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INTRODUCTION

INTRODUCTION
This document explains the Graphic Arts Package features and how they work. Because of the
flexibility of the controls Graphic Arts Package provides, users in any environment can benefit
from the Graphic Arts Package features. Novice users can use the default settings to obtain
optimal results. Expert users with specific needs and requirements in graphic arts and other
markets can also obtain optimal results by customizing the settings.

Terminology and conventions
The documentation for the Fiery EXP50 Color Server uses the following terminology
and conventions.
Term or convention

Refers to

Aero

Fiery EXP50 (in illustrations and examples)

Digital press

DocuColor 5000 digital press

Fiery EXP50

Fiery EXP50 Color Server

Mac OS

Apple Mac OS X

Titles in italics

Other documents in this set

Windows

Microsoft Windows 2000, Windows XP, Windows Server 2003
Graphic Arts Package (Standard)

Graphic Arts Package, Premium Edition (Optional)

Topics for which additional information is available by starting
Help in the software
Tips and information

Important information

Important information about issues that can result in physical harm
to you or others
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About this document
This document describes the features that are available through the print options and utilities
such as ColorWise Pro Tools and Command WorkStation. The features are organized as
follows:
• Features accessible from or used to set the values in ColorWise Pro Tools
– Paper Simulation White Point Editing describes the white point editing feature with
Color Editor.
– Spot-On with Named Colors describes the features used to manage named colors.
– Spot-On with Substitute Colors describes the features used to manage color
substitution.
– Color Setup describes the following features: Control Bar, Auto Trapping, Progressives,
and Halftone Screens.
• Features accessible from Command WorkStation
– ImageViewer describes how to start the ImageViewer application.
– Soft Proofing describes the Soft Proof feature.
– Preflight describes how to perform the Preflight check of your job.
• Features accessible from or used to set the values in utilities other than ColorWise Pro
Tools and Command WorkStation
– Hot Folders Filters describes the filters features.
• Other features
– Postflight describes the Postflight feature and its workflow examples.
– Multiple Plate Separations describes the combine separation feature for more than
four plates.
– Auto Trapping describes the fixed Auto Trapping feature.
– Paper Simulation describes the fixed Paper Simulation feature.
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Graphic Arts Package
The following features are included in Graphic Arts Package:
Feature

Where to set values or access

Print option name

See

Spot-On: named colors

ColorWise Pro Tools Spot-On

Spot Color Matching

Spot-On with Named Colors

Soft proofing

Command WorkStation

Halftone screening

ColorWise Pro Tools
Color Setup

Soft Proofing
Halftone Screen

Color Setup Features

Multiple plate separations

Combine Separation

Multiple Plate Separations

Fixed auto trapping

Auto Trapping

Auto Trapping

Fixed paper simulation

Paper Simulation

Paper Simulation
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Graphic Arts Package, Premium Edition
The following features are included in Graphic Arts Package, Premium Edition:
Feature

Where to set values or access

Print option name

See

Paper simulation white
point editing

ColorWise Pro Tools
Color Editor

Paper Simulation

Paper Simulation White Point
Editing

Spot-On: named colors

ColorWise Pro Tools
Spot-On

Spot Color Matching

Spot-On with Named Colors

Spot-On: color substitution

ColorWise Pro Tools
Spot-On

Substitute Colors

Spot-On with Substitute Colors

Control bar

ColorWise Pro Tools
Color Setup

Control Bar

Color Setup Features

Configurable auto trapping

ColorWise Pro Tools
Color Setup

Auto Trapping

Color Setup Features

Progressives

ColorWise Pro Tools
Color Setup

Progressives

Color Setup Features

Halftone screening

ColorWise Pro Tools
Color Setup

Halftone Screen

Color Setup Features

ImageViewer

Command WorkStation:
ImageViewer

ImageViewer

Preflight

Command WorkStation:
Preflight

Preflight

Hot Folders file filters

Hot Folders

Hot Folders Filters

Postflight

Command WorkStation:
ImageViewer

Postflight

Postflight

Multiple plate separations

Combine Separation

Multiple Plate Separations

Fixed auto trapping

Auto Trapping

Auto Trapping

Fixed paper simulation

Paper Simulation

Paper Simulation
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Available upgrade
The following feature package is available for Fiery EXP50.

Fiery EXP50

Graphic Arts Package

Graphic Arts Package,
Premium Edition

To use Graphic Arts Package,
Premium Edition features

n/a

Optional

Upgrade to Graphic Arts
Package, Premium Edition

Enabling the features at the Fiery EXP50
To access the Graphic Arts Package, Premium Edition features from your computer, the
option must be enabled at the Fiery EXP50. A service technician enables the option at your
site using the Feature Update or Restore/Update Server Software CD and the hardware key
(dongle).
To check whether the option is enabled at the Fiery EXP50, do one of the following:
• Print the Configuration page (see Configuration and Setup)
• Check the Command WorkStation main window (see Utilities)

Updating the status of Graphic Arts Package
Before using the Graphic Arts Package, Premium Edition features with the Fiery EXP50, you
must first enable the option at the Fiery EXP50 and then update the status of the option on
your computer.

Updating the status on Windows
Use the following procedure to update the status of Graphic Arts Package on a Windows
computer.
N OTE : Before updating the status on a Windows computer, you must install the printer driver.

For information about installing the printer driver, see Printing from Windows.

INTRODUCTION
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TO UPDATE THE STATUS ON A WINDOWS COMPUTER
1 Click Start, choose Settings, and then choose Printers.
2 Right-click the Fiery EXP50 and choose Properties.

The Properties dialog box appears.
3 Click the Installable Options tab.

4 Select the Two-Way Communication option.
5 Type the IP address or DNS name of the Fiery EXP50 and click Update.

N OTE : Even though the Graphic Arts Package option, Fiery Graphic Arts Package, appears in

the Available Options area, the Fiery EXP50 is shipped with this option as standard.
N OTE : If you use the Point and Print method to install the printer driver and printer

description file, you must enable Two-Way Communication on the Fiery Advanced
Controller Interface monitor at the Fiery EXP50 for each connection (print, hold, or direct)
before you install them to your computer. For more information about Point and Print, see
Printing from Windows.
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Updating the status on Mac OS
Use the following procedure to update the status of Graphic Arts Package on a computer
running Mac OS X.
N OTE : Before updating the status of Graphic Arts Package on a computer running Mac OS X,

install the printer driver. For information about installing the printer driver, see Printing from
Mac OS.
TO UPDATE THE STATUS ON A COMPUTER RUNNING MAC OS X
1 Start Printer Setup Utility.
2 Select your printer in the Printer List.
3 Choose Show Info from the Printer menu.

The Printer Info dialog box appears.
4 Click Name and Location and choose Installable Options.

5 Select the Graphic Arts Package, Premium Edition from the GA Package list.

N OTE : If the Two-Way Communication feature is enabled, Graphic Arts Package, Premium

Edition appears in the GA Package list.
6 Click Apply Changes.
7 Close the dialog box.

N OTE : Even though the Graphic Arts Package option, Fiery Graphic Arts Package, appears in

the Available Options area, the Fiery EXP50 is shipped with this option as standard.

INTRODUCTION
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Setting up your monitor and the monitor profile
Some Graphic Arts Package features require that a job be displayed with correct colors on
your monitor.
The following features require the correct monitor display:
• Paper Simulation White Point editing (see page 17)
• Spot-On Color Search (see page 33)
• Spot-On Substitute Colors (see page 41)
• Soft Proofing from Command WorkStation (see page 79)
• ImageViewer previewing from Command WorkStation (see page 77)
To display the colors correctly on your monitor, you must set up the monitor display
according to the manufacturer’s recommendations, and specify the correct monitor profile for
your monitor.
Specify the following settings for the monitor display:
• At the monitor: Brightness, Contrast, and Temperature
• From the control panel of the operating system: Resolution, Refresh rate, and Number
of colors
For more information about setting up your monitor and the monitor profile, see the
documentation that accompanies the monitor.
N OTE : Some of the monitor profiles, including those for the FACI monitors, are installed

when you install Command WorkStation.

PAPER SIMULATION WHITE POINT EDITING
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PAPER SIMULATION WHITE POINT EDITING
Although an ICC profile contains a definition of “white,” the white may not always visually
match the human eye, requiring a perceptual adjustment. The Paper Simulation White Point
editing feature allows you to perceptually adjust the hue, brightness, and saturation of the
simulated paper white defined in the ICC profile.

Paper simulation workflow
You can print a job with the Paper Simulation feature set to On from the printer driver
without customizing paper simulation. Many jobs may print satisfactorily with the fixed
default Paper Simulation setting. However, you can customize the paper simulation by editing
the white point values with ColorWise Pro Tools Color Editor. After you customize the
values, print the job with the custom paper simulation values from the printer driver by
setting the Paper Simulation print option to On.
To print a job with the fixed Paper Simulation setting, use the procedure on page 18.
For more information about editing Paper Simulation White Point values and printing
with custom paper simulation values, see page 19.

PAPER SIMULATION WHITE POINT EDITING
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Printing with default Paper Simulation
Use the following procedure to print a job with the fixed Paper Simulation value.
N OTE : The procedures for printing a job from a Mac OS or a Windows computer are similar.

TO PRINT A JOB WITH DEFAULT PAPER SIMULATION
1 Choose Print from your application.
2 Select Fiery EXP50 as your printer and click Properties.

The Properties dialog box appears with the Fiery Printing tab selected.
3 Click the ColorWise print option bar.
4 Click Expert Settings.

The Expert Color Settings dialog box appears.
5 Select Paper Simulation.
6 Click OK to close the Expert Color Settings dialog box.
7 Click OK to close the Properties dialog box.
8 Click Print.

The job prints with the default Paper Simulation White Point setting.

Paper Simulation print option
The following values are available for the Paper Simulation print option:
• Off (Default)
• On
N OTE : If you have not edited the Paper Simulation White Point values with ColorWise Pro

Tools Color Editor and selected On for this option, your job is printed with the default Paper
Simulation values. If you have edited them, your job is printed with the custom Paper
Simulation values.

PAPER SIMULATION WHITE POINT EDITING
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Paper Simulation White Point editing
Your job may print satisfactorily with the fixed Paper Simulation setting. However, you can
customize the Paper Simulation setting by editing the Paper Simulation White Point values
with ColorWise Pro Tools Color Editor.

Paper Simulation White Point dialog box
The Paper Simulation White Point dialog box displays Hue, Brightness, and Saturation
sliders. A graphic under each slider displays the current setting. To adjust the settings, drag the
slider left or right, or type a value in the editable text field to the right of the slider bar.

N OTE : The sliders do not show absolute values. The slider position and associated values are

relative to the paper white definition in effect when you open the dialog box.
Hue
This setting allows you to change the hue of the Paper Simulation White Point. Specify a
value between 0.0 and +359.9. If you specify a value greater than 359.9, it automatically
changes to 359.9. If you specify a value less than 0.0, it automatically changes to 0.0.
Brightness
This setting allows you to change the brightness of the Paper Simulation White Point.
Specify a value between 0.0 and 100.0 (inclusive). If you specify a value greater than 100.0,
it automatically changes to 100.0. If you specify a value less than 0.0, it automatically changes
to 0.0.
Saturation
This setting allows you to change the saturation of the Paper Simulation White Point.
Specify a value between 0.0 and 100.0 (inclusive). If you specify a value greater than 100.0,
it automatically changes to 100.0. If you specify a value less than 0.0, it automatically changes
to 0.0.

PAPER SIMULATION WHITE POINT EDITING
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Preview
This area in the lower-left corner of the dialog box displays a preview of the paper simulation
color, surrounded by a white border for contrast. The preview is based on the monitor profile
you specified next to Current Monitor Profile.
To preview the color correctly with your monitor, select the Monitor Compensation option,
and then select the correct monitor profile for your monitor. For more information,
see page 23.
N OTE : To display the colors correctly with your monitor, you must set the monitor and

monitor settings correctly. For more information, see page 16.

Editing Paper Simulation White Point
To edit a custom profile, do the following:
• Select a CMYK Simulation Profile.
• Select Full (Output GCR) for a simulation method.
• Link the simulation profile to an output profile.
Use the following procedure to access the Paper Simulation White Point dialog box to edit
the values.
N OTE : If Paper Simulation is set to On, and you have defined a substitute color as

C=0, M=0, Y=0, K=0, the values defined in Substitute Colors override those for Paper
Simulation. For information about Substitute Colors, see “Spot-On with Substitute Colors”
on page 41.

PAPER SIMULATION WHITE POINT EDITING
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TO ACCESS THE PAPER SIMULATION WHITE POINT DIALOG BOX
1 Start ColorWise Pro Tools and connect to the Fiery EXP50.

Start ColorWise Pro Tools from a stand-alone application or Command WorkStation, at your
computer or at the monitor connected to the Fiery EXP50.

2 Click Color Editor.
3 Select Simulation from the View list.

1

Select Simulation

1

N OTE : You can edit the white point values of simulation profiles only. You cannot edit those of

output profiles.
4 Select a simulation profile and click Select.

The Color Editor dialog box appears.

PAPER SIMULATION WHITE POINT EDITING
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5 Select Full (Output GCR) in the Edit Mode menu.

1
2

Select Full (Output GCR)
Output profile name

1

2

6 Select an output profile to link to the edited simulation profile.

N OTE : When you print a job with the edited simulation profile, you must select the same

output profile you linked to here to realize the effect of the Paper Simulation White Point
editing.
7 Click Paper Simulation.

The Paper Simulation White Point dialog box appears.

Use the following procedure to edit the Paper Simulation White Point values.

PAPER SIMULATION WHITE POINT EDITING

TO EDIT PAPER SIMULATION WHITE POINT VALUES
1 Select the Monitor Compensation option in the Paper Simulation White Point dialog box.
2 Make sure that the correct monitor profile for your monitor is displayed next to Current
Monitor Profile.
3 If the correct monitor profile is not selected, click Monitor.

The Select Monitor Profile dialog box appears.
4 Select ICC Profiles from the Format list.

5 Select the monitor profile for your monitor and click Open.

The Paper Simulation White Point dialog box appears.
6 Edit the Hue, Brightness, and Saturation values.

Edit the values by dragging the sliders or typing values in the text fields. For detailed
information about the Paper Simulation White Point dialog box, see page 19.
7 View the changes in the preview patch in the lower-left corner of the dialog box.
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8 Click Print.

The Print Test dialog box appears.

9 Select settings from the Paper Size and Input Tray lists and click Print.
10 Click OK to close the Paper Simulation White Point dialog box.
11 Click Save in the Color Editor dialog box.

The Save dialog box appears.
12 Type a new name and click Save.
13 Quit Color Editor.

Printing with custom paper simulation values
After you edit the paper simulation values in Color Editor, you can print a document with the
custom paper simulation values from the printer driver. You can also override the setting with
Command WorkStation.
N OTE : The procedures for printing a job from a Windows or Mac OS computer are

fundamentally the same. The following procedure uses illustrations from a Mac OS computer.
Use the following procedure to print a job with the custom paper simulation values.

PAPER SIMULATION WHITE POINT EDITING

TO PRINT A JOB WITH EDITED PAPER SIMULATION VALUES
1 Choose Print in your application.

The print dialog box appears.
2 Click Copies & Pages and choose ColorSync from the menu.

The ColorSync pane appears.
3 Select In Printer from the Color Conversion list.
4 Click Copies & Pages and choose ColorWise from the menu.

The ColorWise pane appears.

5 Select Two-Way Communication.

For information about enabling Two-Way Communication, see Printing from Mac OS.
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6 Click Expert Settings in the Print Mode area.

The ColorWise Expert Settings dialog box appears.

7 Select the custom simulation profile from the CMYK Simulation Profile list.

Select the simulation profile you saved after editing the Paper Simulation White Point values
in the previous section.
8 Select the Full (Output GCR) option.
9 Select Paper Simulation.
10 Select the output profile that you linked to the custom simulation profile from the Output
Profile menu.
11 Click OK.

The ColorWise pane reappears.
12 Click Print.

The job is printed using your custom CMYK Simulation Profile with the edited
White Point values.

SPOT-ON WITH NAMED COLORS
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SPOT-ON WITH NAMED COLORS
The Spot Color Matching print option automatically matches spot colors with their best
CMYK equivalents so that spot colors can be simulated using the CMYK toner of the digital
press. However, you may want to adjust the default CMYK equivalents to achieve a better
match for your specific printing conditions.

Using Spot-On
Spot-On allows you to adjust and manage lists of spot colors and their CMYK equivalents.
The matching lists of spot colors and CMYK values are known as Spot Color Dictionaries.
Spot-On allows you to maintain multiple Spot Color Dictionaries for each output profile on
the Fiery EXP50.
N OTE : To use the Spot-On features with named colors, you must enable the Spot Color

Matching print option. For more information, see Color Printing.
N OTE : Spot colors identified by names are printed with their defined CMYK values. The edits

to the output profile made with Color Editor do not affect how spot colors print. However,
the edits to a job made with the color adjustment features in ImageViewer affect all colors in
the job, including spot colors.

Starting Spot-On
To use Spot-On, you must specify the output profile associated with the Spot Color
Dictionary that you want to edit.
If you select Output profile X and redefine PANTONE 123 from 30%M to 50%M using
Spot-On, you will get 50%M when you print a job with Output profile X. If you print a job
with Output profile Y, you will get the original value. If you select Output profile X and create
a custom color named “My Purple” and define it as 80C 40M, ColorWise automatically
calculates the Lab values using Output profile X and creates new CMYK values for use with
Output profile Y.
N OTE : The Fiery EXP50 allows only one user to connect to Spot-On at a time.

SPOT-ON WITH NAMED COLORS
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TO START SPOT- ON
1 Start ColorWise Pro Tools and connect to the Fiery EXP50.

2 Click Spot-On.

The Select Output Profile dialog box appears.
3 Select an output profile and click OK.

1
2

Current output profile
Output profiles to link

1
2

The Spot-On main dialog box appears. The CMYK values displayed in the dialog box are
calculated with respect to the specified profile.
N OTE : When you print a job, select the same output profile from the printer driver as the one

that is selected in the Select Output Profile dialog box. Otherwise, color adjustments based on
Spot-On have no effect.
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Spot-On main window
The Spot-On main window lists color groups that represent libraries of spot colors on the
Fiery EXP50. Tool icons for working with colors appear at the top of the window.
1
1
2
3
4
5
6
7
8
9
10
11
12
13

Output profile
Save
Upload
Download
Cut
Copy
Paste
Close all
Print
Up
Down
Custom color group
Default color groups

2

3

4

5

6

7

8

9

10

11

12

13

By default, the Fiery EXP50 includes several PANTONE libraries along with a System library.
The DIC, HKS, and TOYO libraries are also available. These factory default libraries appear
marked with the default group icon (
).
You can add custom color groups and colors to the Spot-On window (see page 32). Added
groups appear marked with the custom group icon (
). Both default and custom groups
can be opened to display included colors.

SPOT-ON WITH NAMED COLORS
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TO OPEN AND CLOSE A COLOR GROUP
1 To open a color group, double-click the icon to the left of the group name.

When you open a group, all the colors in the group are displayed, and the group icon changes
appearance.

2 To close a color group, click the icon to the left of the group name.
3 To close all the color groups in the list, choose Close All from the Edit menu.

Working with existing colors
Spot-On allows you to view and manage existing groups of colors on the Fiery EXP50 and
search for a particular color in the Spot-On list.
Color groups in the Spot-On window appear in the order of their priority. Highest priority is
assigned to color groups at the top of the list. For instance, if two colors from two different
color groups have the same name, the Fiery EXP50 uses the color from the higher group and
disregards the other color. By managing the priority of colors in this way, you can maintain
several CMYK variants for the same spot color.

SPOT-ON WITH NAMED COLORS
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TO REARRANGE THE PRIORITY OF COLORS
1 To rearrange an entire color group, select the desired color group. To rearrange an individual
color, select the desired color.

Individual spot colors are marked with circular color icons.
2 To move the selection up or down in the list, click the Up or Down icon in the toolbar.
3 To paste the selection in a different location in the list, click the Cut or Copy icon in
the toolbar.

N OTE : The Cut operation is available only for custom colors.
4 Click the location in the list where you want to paste the cut or copied selection, and then
click the Paste icon in the toolbar.

When you paste a default PANTONE color or group, a warning message appears, asking you
to rename the selection because of the multiple prefixes and suffixes for the PANTONE colors
and groups. Select the desired prefix and suffix from the lists for the new name, and then click
OK. The pasted selection becomes a custom color or group with the specified name.

TO FIND A SPECIFIC COLOR
1 Choose Find from the Edit menu.

The Find dialog box appears.
2 Specify the name of the color that you want to find and click OK.

Spot-On searches for the specified color, starting from the top of the color list. Once located,
the color appears selected in the color list.
3 To find additional colors based on the same search criteria, choose Find Again from the
Edit menu.

SPOT-ON WITH NAMED COLORS
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Creating custom colors
Spot-On provides a number of default color groups in the color list. You can add your own
custom spot colors and groups to the list.
TO ADD A NEW COLOR OR COLOR GROUP
1 Select the location in the group or color list where you want the addition to be placed.
2 Choose New Group from the Edit menu to insert a new group, or choose New Color to insert a
new color.

A new color group entry or color entry appears as Untitled.
TO RENAME A CUSTOM COLOR OR GROUP
1 Select the specific color or group that you want to rename.
2 Double-click the name of the color or group.
3 Type the new name exactly as it appears in the job, including uppercase and lowercase
characters and spaces, as needed.

This new name is supplied by the source application (such as Adobe Illustrator or
QuarkXPress) to your PostScript job. If you do not have access to the source document, use
Postflight to view the list of the exact color names used in your job. A Postflight Detailed
Report prints all the named colors used in a document. For more information about
Postflight, see page 98.
N OTE : Default groups or colors (such as PANTONE) cannot be renamed.

Downloading custom color groups
You can download custom color groups from your computer to the Fiery EXP50.
Downloaded groups are added as custom groups to the Spot-On color list and are
immediately enabled for use on the Fiery EXP50.

SPOT-ON WITH NAMED COLORS
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TO DOWNLOAD CUSTOM COLOR GROUPS
1 Select the location in the color list where you want to add the downloaded group.
2 Choose Download from the File menu.

The Select file dialog box appears.

N OTE : The supported file format for download is ICC Named Color Profile.
3 Locate and select the desired color group, and then click Open.

The downloaded group is added to the specified location in the Spot-On list. If you did not
specify a location, the group is added to the top of the list.
If the downloaded group has the same name as an existing group in the list, you are prompted
to rename the downloaded group.

Uploading custom color groups
You can upload custom color groups from the Fiery EXP50 to your computer as ICC files.
The upload feature allows you to share a group by creating a local copy that can be
downloaded to another Fiery EXP50.
You must save a color group to the Fiery EXP50 before you can upload it to your computer.
To upload a factory default group, copy and paste the group as a new custom group, and then
upload the group.

SPOT-ON WITH NAMED COLORS
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TO UPLOAD CUSTOM COLOR GROUPS
1 Select the name of the color group that you want to upload.
2 Choose Upload from the File menu.

The Save As dialog box appears.

3 Browse to the location where you want to save the file, name the file, and then click Save.

Editing color values
If an existing spot color is not printing as intended, edit the color values as needed to achieve
your intended result. Edit color values by entering the exact CMYK values in the Spot-On
main window or in the Set Center Patch Color dialog box, or using the Spot-On Color Search
feature.
Use the following procedures to edit a named color by entering the exact CMYK values.
To target a color using Spot-On Color Search, see page 36.
TO EDIT A COLOR IN THE SPOT-ON MAIN WINDOW
1 Select the color that you want to edit.
2 Double-click the value under C, M, Y, and K, and enter a new number for each color channel.

The edited color appears in the color list.
N OTE : The edited color is not saved until you choose Save from the File menu.
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TO EDIT A COLOR IN THE SET CENTER PATCH COLOR DIALOG BOX
1 Select the color that you want to edit.
2 Double-click the color icon.

The Spot-On Color Search dialog box appears with the selected color in the center.
3 Click the center patch.

The Set Center Patch Color dialog box appears.

4 Indicate whether you want to enter CMYK values as percentages or Device Codes.

The Percentages option allows you to enter color values between 0 and 100%, in increments
of 0.5. Values out of this range are rounded to the nearest whole or half percentage.
The Device Codes option allows you to enter color values between 0 and 255. This option
reflects the full range of color values that the Fiery EXP50 can reproduce and provides finer
gradations of color than are possible with Percentages.
5 Enter the C, M, Y, and K values of your specific color in the appropriate fields.

Use the Tab key to move from field to field. As you enter each new value, the preview patch
updates to reflect the old and new colors.
6 Click OK.

The new color is displayed in the center of the Spot-On Color Search dialog box.
7 Click OK.

The edited color appears in the color list of the Spot-On main window.
Use the following procedure to target a color using the Spot-On Color Search dialog box.
Beginning with an approximate color in the Spot-On Color Search dialog box, adjust the hue,
saturation, and lightness of the color until you achieve an acceptable match.
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TO TARGET A COLOR USING SPOT- ON COLOR SEARCH
1 Select the color that you want to edit.
2 Double-click the color icon.

The Spot-On Color Search dialog box appears with the current color in the center.

3 To update the center patch to a neighboring color that more closely matches the target, click
the corresponding neighbor patch.

Neighboring patches represent variations from the center patch and can be selected if they
offer a closer match to the desired color. Clicking one of these patches updates the center
patch to the new color and provides a new selection of neighboring colors. These patches are
either lightness or saturation neighbors, depending on the option you select in the following
step.
N OTE : When you select certain colors, an exclamation point icon may appear in the

upper-right corner of the dialog box. This icon indicates that one or more colorants have
reached their maximum values.
4 Use the following techniques to control how neighboring color patches are generated:
Select Lightness or Saturation in the Color Directions Legend.

Lightness generates neighbor patches based on darker to lighter shades of the original color.
This variation is displayed from left to right, with the original color remaining in the center of
the middle group.
Saturation generates neighbor patches based on less saturated to more saturated variations
of the original color. This variation is displayed from left to right, with the original color
remaining in the center of the middle group.
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Select a setting from the Color Spacing menu to control the closeness of the neighbor
patches.

A higher setting generates neighbor patches that differ more noticeably from the center color.
As you get closer to your target color, reduce the color spacing to a smaller value.
Select Monitor Compensation to simulate how all the on-screen color patches will appear
when printed on paper.

This simulation depends on the monitor profile that has been configured for your monitor.
To specify the monitor profile, choose Preferences from the Edit menu in the Spot-On
main window.
Make sure that you set your monitor according to the manufacturer’s recommendations and
select the correct monitor profile for your monitor (including the FACI monitor). For more
information, see page 16.
5 Continue adjusting the color patch controls and clicking neighbor patches until the color you
want appears in the center patch.
6 Click Print Pattern.

N OTE : It is very difficult to accurately match spot colors on a monitor. Always print a Test

Page to ensure the proper color match.
7 Select the appropriate settings from the Output Style, Paper Size, and Paper Tray lists.

For Output Style, select Color Search Pattern or Color Neighbor Pattern. Color Search
Pattern prints patches with the same pattern displayed in the Color Search dialog box. Color
Neighbor Pattern prints patches in a three column by eight row format.
For Paper Size, select the size of the paper that you want to use for printing the patches.
For Paper Tray, specify the paper source for the paper that you want to use.

SPOT-ON WITH NAMED COLORS

38

8 Click OK to print the patches.

The Print Pattern test page provides the following information:
• Center patch color CMYK value
• Color spacing
• Lightness or Saturation neighbors selected
• Output profile selected
The goal of Spot-On Color Search is to find the color values that make a printed color patch
match a target, not its screen simulation of it. Printing a Print Pattern of neighbor color
patches allows you to compare the printed patches to the color target. After you compare the
printed patches and find the one that matches most closely, you can select the corresponding
patch on-screen.
9 Select the desired target color in the Spot-On Color Search dialog box and click OK.

The edited color appears in the color list of the Spot-On main window.

Using a measurement instrument to target colors
If you have the EFI Spectrometer ES-1000, you can import measured color values directly
into Spot-On. This feature allows you to target matches based on the actual colors of
immediate objects, such as the red of a printed logo or the yellow of a packaging envelope.
TO IMPORT COLOR MEASUREMENTS

INTO SPOT- ON

1 Install and set up the ES-1000 for use with your computer.

For installation and setup instructions, see the documentation that accompanies the
instrument.
2 Choose Start from the Instrument menu.

The Choose Port dialog box appears.
3 For Instrument, select the instrument that you will use to take measurements. For Port,
select the serial port connection of the instrument. Click OK.
4 Place the ES-1000 over the target color, making sure to center the sample aperture over the
color. Press Measure to take the measurement.
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The measured CMYK values are imported into Spot-On as follows:
• If an individual color is selected in the color list, it updates to the measured color.
• If a group is selected in the color list, a new color with the measured values is created
within the group.
• If the Spot-On Color Search dialog box is open, the center patch updates with the
measured values, and the neighbor patches update accordingly.
• If the Set Center Patch Color dialog box is open, the measured values are imported into
the CMYK entry fields.
5 When you are finished taking color measurements, choose Stop from the Instrument menu.

Spot-On closes the connection to the instrument.

Reverting default colors to factory settings
You can revert default colors to their factory default settings. Revert all colors within a default
color group, or revert one or more specific colors within a default color group, so that only
those colors are reset to the factory default settings.
TO REVERT ALL COLORS WITHIN A DEFAULT COLOR GROUP TO FACTORY DEFAULTS
1 Click the icon to the left of the name of the group that you want to revert.
2 Choose Revert Group from the File menu.

A warning message appears.
3 Click OK.

TO REVERT SPECIFIC COLORS WITHIN A DEFAULT COLOR GROUP TO FACTORY DEFAULTS
1 Click the icon to the left of the name of the group that contains the colors you want to revert.
2 Select the colors that you want to revert to the factory defaults.

To select more than one color, Shift-click to select an adjacent color or Control-click to select
a nonadjacent color.
3 Choose Revert Factory Color from the File menu.

A warning message appears.
4 Click OK.
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Saving changes and exiting Spot-On
To enable your spot color matches for use with the Fiery EXP50, save your edits before you
exit Spot-On. This ensures that all your changes to Spot-On color definitions are stored on
the Fiery EXP50 and are available for use when printing documents that contain spot colors.
The following edits do not require saving to take effect:
• Rearranging the priority level of a color group
• Downloading a color group
• Clearing or deleting a color group
TO SAVE THE SPOT- ON COLOR LIST
1 Choose Save from the File menu.
2 Click Close in the upper-right corner of the Spot-On main window to exit the utility.
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SPOT-ON WITH SUBSTITUTE COLORS
In addition to managing “named” colors (spot colors and custom colors), Spot-On allows you
to create a list of “substitute” colors with Graphic Arts Package, Premium Edition. These are
colors that, when called for in a document by their RGB or CMYK values, are substituted
with a different color having the CMYK values from the Spot-On color dictionary. This
permits exact color control and overrides individual RGB and CMYK colors.
N OTE : Color substitutions affect only text, vector, and line art. They have no effect on

raster images.
N OTE : When a color is defined as a substitute color, the settings for an RGB color (such as

RBG Source, Rendering Style, and RGB Separation) or CMYK color (such as CMYK
Simulation Profile, CMYK Simulation Method, and Paper Simulation) have no effect. The
color is converted with a process similar to spot color conversion.
For information about managing named colors, see Spot-On with Named Colors.

Substitute Colors workflow
The Substitute Colors workflow involves defining the substitute color values with Spot-On,
and then printing a document with the Substitute Colors print option set to On from the
printer driver. You can also change the print option setting using Command WorkStation
overrides.
N OTE : You cannot use the Substitute Colors and Postflight features at the same time.

These print options are constrained from the printer driver.

Creating a color for substitution
Use the following procedure to add a new substitute color in a substitute group and specify
the value-name for a color to substitute.
N OTE : A new substitute color can be added only to a substitute group.
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TO ADD A NEW SUBSTITUTE COLOR AND SPECIFY THE VALUE-NAME FOR SUBSTITUTION
1 Start ColorWise Pro Tools and connect to the Fiery EXP50.

N OTE : Start ColorWise Pro Tools from a stand-alone application or Command WorkStation,

at your computer or at the monitor connected to the Fiery EXP50.

2 Click Spot-On.

The Select Output Profile dialog box appears.

1
2

Current output profile
Output profiles to link

1
2

3 Select an output profile and click OK.

The Spot-On main dialog box appears.
1
1
2
3
4
5
6
7
8
9
10
11

Output profile
Save
Upload
Download
Cut
Copy
Paste
Close all
Print
Up
Down

2

3

4

5

6

7

8

9

10

11

N OTE : When you print a job, select the same output profile from the printer driver as the one

that is selected in the Select Output Profile dialog box. Otherwise, color adjustments based on
Spot-On have no effect.
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4 Select the location in the group list where you want the addition to be placed.
5 Choose New Substitute Group from the Edit menu.

A new substitute group entry appears as Untitled.
1
1

Output profile

6 Double-click Untitled and type a new name.
7 Select the substitute group and choose New Substitute Color from the Edit menu.

N OTE : If the substitute group already contains substitute colors, select the color above the

location where you want to add a new substitute color.
The Add Substitute Color dialog box appears.

8 Select a color mode for the substitute color.
9 Select a tolerance degree for the substitute color.

For information about Tolerance, see page 49.
10 Type the values for the color that you want to substitute.
11 Click OK.

The substitute color appears at the specified location.

SPOT-ON WITH SUBSTITUTE COLORS

44

Defining the color values for a substitute color
After you specify the original color to substitute, define CMYK values for the substitute color
by typing the exact CMYK values in the Spot-On main window or Set Center Patch Color
dialog box, or use Spot-On Color Search.
For instructions on defining a substitute color by typing the exact CMYK values, see the
following sections. To define a substitute color in the Spot-On Color Search dialog box,
see page 46.
TO DEFINE A SUBSTITUTE COLOR IN THE SPOT-ON MAIN WINDOW
1 Start ColorWise Pro Tools and connect to the Fiery EXP50.

2 Click Spot-On.

The Select Output Profile dialog box appears.
3 Select an output profile and click OK.

The Spot-On main dialog box appears.
4 Select the color that you want to substitute.
1
1

Output profile

5 Double-click the value under C, M, Y, and K, and type a new number for each color channel.

The new values for the substitute color appear in the color list.
N OTE : The edited color is not saved until you choose Save from the File menu.
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TO DEFINE A SUBSTITUTE COLOR IN SET CENTER PATCH COLOR
1 Select the color that you want to substitute.
2 Double-click the color icon.

The Spot-On Color Search dialog box appears with the selected color in the center.

1

Center patch

1

3 Click the center patch.

The Set Center Patch Color dialog box appears.

4 Type values for each C, M, Y, and K color channel.

For information about using Set Center Patch Color, see Spot-On with Named Colors.
5 Click OK.

The new color appears in the center in the Spot-On Color Search dialog box.
6 Click OK.

The new color appears in the color list of the Spot-On main window.
N OTE : The edited color is not saved until you choose Save from the File menu.

Use the following procedure to target a substitute color using the Spot-On Color Search
dialog box.
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TO DEFINE A SUBSTITUTE COLOR USING SPOT- ON COLOR SEARCH
1 Select the color that you want to substitute.
2 Double-click the color icon.

The Spot-On Color Search dialog box appears, displaying the current color in the center.

1

Neighboring patch

1

3 Click neighboring patches until you find the color that you want to use for the substitution.

For more information about using Spot-On Color Search, see Spot-On with Named Colors.
4 Click OK.

The new substitute color appears in the color list of the Spot-On main window.
N OTE : The edited color is not saved until you choose Save from the File menu.
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Printing a job with a substitute color
After you define CMYK values for substitution in Spot-On, you can print a document with
the substitute color from the printer driver. You can also override the print option setting
using Command WorkStation.
N OTE : The procedures for printing a job from a Mac OS and a Windows computer

are similar.
TO PRINT A JOB WITH A SUBSTITUTE COLOR
1 Open a document in your application.
2 Choose Print.
3 Click Copies & Pages and choose ColorWise from the menu.

The ColorWise pane appears.

4 Select Substitute Colors.
5 Click Print.

The job is printed with the substitute you defined in Spot-On.
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Substitute Color dialog box
You can define the color mode and tolerance range for a substitute color in the Add Substitute
Color or Rename Substitute Color dialog box.

N OTE : The Add Substitute Color dialog box appears when you choose Edit>New Substitute

Color after selecting a substitute color group in the list. The Rename Substitute Color dialog
box appears when you double-click the bracketed section of a substitute color.
N OTE : The Add Substitute Color and Rename Substitute Color dialog boxes offer the same

control in defining a substitute color.
• Substitute Color: Select the following color modes for a substitute color:
– CMYK (0-100%)
– RGB (Device Code 0-255)
– RGB (0-100%)
• Tolerance: Select the following tolerance ranges for a substitute color:
– Small (indicated in lowercase)
– Large (indicated in uppercase)
To avoid entry errors, the Add Substitute Color and Edit Substitute Color dialog boxes
display the values in the following predefined formats. The dialog boxes also display uppercase
or lowercase characters and a “%” symbol, depending on the selections.
• CMYK (0-100%) mode

– Small: <“0”%c, “0”%m, “0”%y, “0”%k>
– Large: <“0”%C, “0”%M, “0”%Y, “0”%K>
• RGB (Device Code 0-255) mode

– Small: <“0”r, “0”g, “0”b>
– Large: <“0”R, “0”G, “0”B>
• RGB (0-100%) mode

– Small: <“0”%r, “0”%g, “0”%b>
– Large: <“0”%R, “0”%G, “0”%B>
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Principles for Substitute Colors
In setting the values for Substitute Colors, keep in mind the following principles.

Tolerance range
The accuracy of the substitute color is affected by various elements, such as applications,
operating systems, printer drivers, and distilling processes. To accommodate the “errors” that
occur because of the rounding rules between the numbers entered by users and the numbers
received by the Fiery EXP50, the options of the small and large tolerance ranges are provided
for color substitution.
The following table provides Small and Large substitution tolerance ranges for each
color mode.
Color mode

Small tolerance range

Large tolerance range

CMYK (0-100%)

+/- 0.25%

+/- 0.5%

RGB (Device Code 0-255)

+/- 0.25

+/- 1

RGB (0-100%)

+/- 0.25%

+/- 0.5%

N OTE : Values for tolerance ranges are approximate.
• CMYK (0-100%)

– Small: A substitute color replaces any color that falls within the nearest +/- 0.25% of
the color value entered.
– Large: A substitute color replaces any color that falls within the nearest +/- 0.5% of the
color value entered.
• RGB (Device Code 0-255)

– Small: A substitute color replaces any color that falls within the nearest +/- 0.25 of the
color value entered.
– Large: A substitute color replaces any color that falls within the nearest +/- 1 of the
color value entered.
• RGB (0-100%)

– Small: A substitute color replaces any color that falls within the nearest +/-0.25% of the
color value after scaling.
– Large: A substitute color replaces any color that falls within the nearest +/-0.5% of the
color value after scaling.
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Color substitution
A color substitution takes place when a substitute color is defined with a different set of
CMYK values for the same value-name as the original color.
The following color examples show how a substitution works.
• Original color: <100, 0, 0, 0> for the CMYK values (cyan)
• Substitute 1: <0, 100, 100, 0> (red)
• Substitute 2: <100, 0, 100, 0> (green)
N OTE : In the examples, the extreme values and terms “red” and “green” are used for illustrative

purposes only.
The following table shows color substitution with different sets of CMYK values assigned to
the same original color.
Substitution
value-name

CMYK
values

Before
substitution

After
substitution

Original color

—

<100, 0, 0, 0>

—

—

Substitute 1

<100.0c, 0.0m, 0.0y, 0.0k>

<0, 100, 100, 0>

cyan

red (see the following)

Substitute 2

<100.0c, 0.0m, 0.0y, 0.0k>

<100, 0, 100, 0>

cyan

green (see the following)

Substitute 1

Substitute 2

Priority scheme
If two substitute colors are defined with the same value-names, but with different sets of
CMYK values and different tolerance ranges, Spot-On resolves the priority of substitution
according to the order of color in the group.
Spot-On process color substitution is based on the order of color in the group. The color
entries at the top of the list have priority over the colors at the bottom of the list. Spot-On
scans the list from top to bottom and processes substitution in linear order. When a color is
remapped, it is not overridden by any subsequent substitution call.
The following color examples show how the priority scheme works.
• Original color: <100, 0, 0, 0> for the CMYK values (cyan)
• Substitute 3: <0, 100, 100, 0> (red) with a small tolerance
• Substitute 4: <100, 0, 100, 0> (green) with a large tolerance
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N OTE : In the examples, the extreme values and terms “red” and “green” are used for illustrative

purposes only.
Order of the colors
• Case 1: Substitute 3 (red) is higher than Substitute 4 (green) in the list.
• Case 2: Substitute 4 (green) is higher than Substitute 3 (red) in the list.
The following table shows the scheme of priority when the same value-names are assigned to
the original color with different sets of CMYK values and different tolerance ranges.
Color
order

Substitution
value-name

Original color

CMYK values

Before
substitution

After
substitution

<100, 0, 0, 0>

Case 1

Substitute 3
Substitute 4

<100.0c, 0.0m, 0.0y, 0.0k>
<100.0C, 0.0M, 0.0Y, 0.0K>

<0, 100, 100, 0>
<100, 0, 100, 0>

cyan

red
(see the following)

Case 2

Substitute 4
Substitute 3

<100.0C, 0.0M, 0.0Y, 0.0K>
<100.0c, 0.0m, 0.0y, 0.0k>

<100, 0, 100, 0>
<0, 100, 100, 0>

cyan

green
(see the following)

Case 1

Case 2

Substitute 3 and Substitute 4 have the same value-names, but depending on their order in the
list, Spot-On produces different results.
• In Case 1, Substitute 3 is given higher priority because it is higher in the list. Subsequently,
substitution with Substitute 4 takes place because its tolerance range is larger.
• In Case 2, Substitute 4 is given higher priority because it is higher in the list.
No subsequent substitution with Substitute 3 takes place because its tolerance range
is smaller.

Uploading and downloading a substitute color group
Like named color groups, you can upload or download a substitute color group as an ICC
profile. The substitute color definitions are saved with private tags as part of an ICC profile,
allowing you to export the Substitution Group definitions between multiple print servers.
However, Substitution Group definitions are recognized only by the Fiery EXP50 with
Graphic Arts Package, Premium Edition enabled.
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COLOR SETUP FEATURES
With Graphic Arts Package, Premium Edition, ColorWise Pro Tools Color Setup offers the
following customizable features, in addition to the Color Process Flow feature:
• Control Bar
• Auto Trapping
• Progressives
• Halftone Screens
For information about Color Process Flow, see Color Printing.
N OTE : The ColorWise Pro Tools applications for Windows and Mac OS computers

are similar.

ColorWise Pro Tools Color Setup features
Access the Control Bar, Auto Trapping, Progressive, and Halftone Screens features from Color
Setup.
For information about these features, see the following sections:
• Control Bar (see page 54)
• Auto Trapping (see page 62)
• Progressives (see page 66)
• Halftone Screens (see page 70)
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Using Color Setup
Use the following procedure to start Color Setup.
N OTE : For information about installing ColorWise Pro Tools and configuring a connection,

see Color Printing.
TO START COLOR SETUP
1 Start ColorWise Pro Tools and connect to the Fiery EXP50.

N OTE : Start ColorWise Pro Tools from a stand-alone application or Command WorkStation,

at your computer or at the monitor connected to the Fiery EXP50.

2 Click Color Setup.

The Color Setup main window appears with the Color Process Flow tab selected.
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Control Bar
Control Bar allows you to add a static color bar and dynamic job information to each printed
page at the user-defined location. The feature can be set as a server default or overridden on a
per-job basis.
The default Control Bar is designed to fit the Fiery EXP50’s default paper size, Letter/A4, or
larger. You can create Control Bars for other paper sizes.
N OTE : If a Control Bar does not fit on the page, it will be clipped.
N OTE : If a background color is defined as “white” for a user-defined Control Bar, it must be

defined in the CMYK color space for the Paper Simulation feature to take effect. For more
information about Paper Simulation, see page 17.

Control Bar workflow
The default Control Bar provides a color bar and dynamic job information. Print a job with
the default Control Bar by setting the Control Bar print option to On from the printer driver.
Many jobs print satisfactorily with the default Control Bar, but if you require your own color
bars, create them by defining custom values in the Control Bar Definition dialog box. After
you define a custom Control Bar in the Control Bar pane in Color Setup, you can print a job
with the custom Control Bar from the printer driver.
To print a job with the default Control Bar, see the following section. For information about
the Control Bar pane, see page 56. To create your own Control Bars, see page 57. To print a
job with a custom Control Bar, see page 61.

Printing with the default Control Bar
Print a job with the default Control Bar by setting the Control Bar print option to On from
the printer driver.
TO PRINT A JOB WITH THE DEFAULT CONTROL BAR
1 Choose Print from your application.
2 Select Fiery EXP50 as your printer and click Properties.

The Properties dialog box appears, with the Fiery Printing tab selected.
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3 Click the Reporting print option bar.

4 Select On from the Control Bar list.
5 Click OK.
6 Click Print.

The job is printed with the default Control Bar.

1
2

2

Job information
Static color bar

1
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Control Bar pane
The Control Bar tab allows you to do the following:
• Set the Print Control Bar option to On (see the following section).
• View the definition of a Control Bar (see page 56).
• Define a new Control Bar (see page 57).
• Edit a Control Bar (see page 60).
• Duplicate a Control Bar (see page 61).
• Delete a Control Bar (see page 61).
• Restore the factory default values (see page 61).
Setting the Print Control Bar option to On
Selecting the Print Control Bar option sets the Printer’s Default value to On. If this option
is selected, a Control Bar is printed on all pages sent to the Fiery EXP50 when Printer’s
default is selected from the printer driver or with Command WorkStation.
Viewing the definition of a Control Bar
Selecting a Control Bar in the Available Control Bar list allows you to view the settings
information in the Control Bar Definition area. With this feature, you can identify the
Control Bar without opening the Control Bar Definition dialog box.
The following information is displayed in the Control Bar Definition area:
• Color Bar EPS File
• Job Information
• Text Location
• Distance from edge

COLOR SETUP FEATURES

57

Defining a new Control Bar
When you open the Control Bar pane for the first time, only the default Control Bar is
available in the Control Bar Definition dialog box. You can create a custom Control Bar that
better fits your needs.
Use the following procedure to access the Control Bar pane and create a new Control Bar.
TO CREATE A CUSTOM CONTROL BAR
1 Start ColorWise Pro Tools and connect to the Fiery EXP50.
2 Click Color Setup.
3 Click the Control Bar tab.
4 Click New in the Control Bar pane.

The Control Bar Definition dialog box appears.
5 Define the values for each option.

For information about Control Bar options, see “The Control Bar Definition dialog box” on
page 58.
6 Click OK.

A custom Control Bar is created.
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The Control Bar Definition dialog box

The explanation of each section in the Control Bar Definition dialog box is as follows:

N OTE : The Control Bar Definition dialog box is displayed when you click New in the

Color Setup dialog box.
N OTE : Each field of this dialog box initially displays the value from the Control Bar that is

currently set as default, except for the System Page Size.
• System Page Size: A System Page Size label with two numbers is printed with each Control
Bar. These numbers are the exact numbers to enter when creating a custom Control Bar.
Every page produced by the Fiery EXP50 has a System Page Size. These two numbers
represent the width and height of the page, in points, as processed by the system. Page sizes
that are not defined use the Default system Control Bar.
To find the System Page Size for a job, see a previously printed Control Bar on a document
using the targeted paper size and orientation.
• Description: This field allows you to add a one-line description of the custom Control Bar
for your future reference.
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• Control Bar EPS File: This option allows you to select the following:
– Standard: (provided as a default)
– Custom: (user-designed EPS)
– None: (no EPS file is required)
The EPS file contains a color bar and any logo or static information that you want to
include on the page.
• Job Information: The options vary, but typically the following information is available:
– Page Size
– Control Bar Name
– User Name
– Job Title
– Date/Time
– Server Name
– Printer
– Calibration Date/Time
– Output Profile
– RGB Source Profile
– RGB Separation
– Rendering Style
– CMYK Simulation Profile
– CMYK Simulation Method
– Paper Simulation
– Spot Color Matching
– Black Text/Graphics
– Black Overprint
– Group Name
– Notes
– Instructions
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• Text Location: This list allows you to select the location in which you want the job
information printed on the page:
– Bottom
– Left
– Top
– Right
For the location and orientation of the job information, see the following illustration.

• Distance from the edge: This text field allows you to define the distance from the lower-left
corner at which you want the job information to begin printing. The settings to define are
as follows:
– Units: Select inches, millimeters, or points from the Units list.
– Horizontal: Type the value.
– Vertical: Type the value.
Editing a Control Bar
You can edit all of the values in the Control Bar Definition dialog box, with the exception of
System Page Size, which appears dimmed.
The System Page Size for the default Control Bar refers to different system page sizes. For
other Control Bars, values are displayed in the text field.
N OTE : To display the Control Bar Definition dialog box for editing, select a Control Bar in

the Available Control Bar list, and then click Edit.
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Duplicating a Control Bar
When you duplicate a Control Bar, all the values of the original Control Bar are displayed.
You can edit and save the duplicate as a custom Control Bar.
If you edit and save a Control Bar as a custom Control Bar, you must change the System Page
Size values. No two Control Bars can use the same values. If you try to save the custom
Control Bar without changing the System Page Size values, a warning message appears.
Because a Control Bar is not a part of a job, a document can be printed with one Control Bar
and then with another one if the Control Bar definition has changed. To keep the Control Bar
and reuse it later, you must save the changes as a custom Control Bar.
N OTE : To display the Control Bar Definition dialog box for duplicating, select a Control Bar

in the Available Control Bar list and click Duplicate.
Deleting a Control Bar
You can delete a Control Bar from the list in the Available Control Bar dialog box. You are
prompted to confirm the deletion.
N OTE : You cannot delete the default Control Bar.

Restoring the factory default values
The Control Bar Definition dialog box allows you to delete all user-defined Control Bars and
restore the default Control Bar to its original state by clicking Factory Defaults.

Printing with a custom Control Bar
The procedure to print a job with a custom Control Bar is basically the same as to print with
the default Control Bar (see page 54). Use the following procedure to print with a custom
Control Bar.
TO PRINT A JOB WITH A CUSTOM CONTROL BAR
1 Choose Print from your application.
2 Select Fiery EXP50 as your printer and click Properties.

The Properties dialog box appears with the Fiery Printing tab selected.
3 Click the Reporting print option bar.
4 Select On from the Control Bar list.

N OTE : Selecting On from the printer driver affects the current job only. If you selected Print

Control Bar in the Control Bar pane, selecting Printer’s Default has the same effect as On.
Selecting Print Control Bar in the Control Bar pane sets the default value to On for all jobs.
5 Click OK.
6 Click Print.

The job is printed with the Control Bar specified in the Control Bar Definition dialog box.
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Configurable Auto Trapping
Trapping is a technique where some objects are printed slightly larger or smaller than you have
specified in an application, in order to prevent white edges around the objects. These white
edges, or “hollows,” can be caused by factors, such as misregistration, the physical properties
of the toners, and the stiffness of the media.
The configurable Auto Trapping feature provides you with advanced trapping settings and
gives you full control over their values. The Fiery EXP50 is shipped with values that are
optimized for the print device using regular paper, but if these values do not provide the
results necessary for the media that you use, modify the values to meet your requirements.

Configurable Auto Trapping workflow
The fixed values are set as default for Auto Trapping. The Fiery EXP50 applies these fixed
values when you set Auto Trapping to On, with generally good results. However, to customize
the values for Auto Trapping, define the values in the Auto Trapping pane in Color Setup.
After you define the values, print a job with Auto Trapping set to On from the printer driver.

Printing with default Auto Trapping
You can print a job with default Auto Trapping by setting the Auto Trapping print option to
On from the printer driver.
TO PRINT A JOB WITH DEFAULT AUTO TRAPPING
1 Choose Print from your application.
2 Select Fiery EXP50 as your printer and click Properties.

The Properties dialog box appears with the Fiery Printing tab selected.
3 Click the Image Quality print option bar.

4 Select Auto Trapping.
5 Click OK.
6 Click Print.

The job is printed with the default Auto Trapping values.
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Auto Trapping pane
Access the Auto Trapping pane by clicking the Auto Trapping tab in the ColorWise Pro Tools
Color Setup dialog box (see page 65).

The settings in the Auto Trapping pane allow you to perform the following tasks:
• Set the Apply Auto Trapping option to On (see the following section).
• Specify the trap width (see page 64).
• Specify the trap color reduction (see page 64).
• Specify the trap shape (see page 65).
• Specify the trap object types (see page 65).
• Restore the factory default values (see page 65).
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Setting the Apply Auto Trapping option to On
When you select the Apply Auto Trapping option, you set the Printer’s default value to On.
When you select Printer’s default from the printer driver, the configured auto trapping is
applied to all jobs sent to the Fiery EXP50.
Specifying Trap Width
Trap Width values determine how thick the trapped areas are. Specify the following values:
• Horizontal: Defines the horizontal thickness of the trapped areas (0-10 pixels).
• Vertical: Defines the vertical thickness of the trapped areas (0-10 pixels).
When you select the Uniform option, the horizontal and vertical Trap Width values are the
same. If the values were set before you selected Uniform, the higher of the two values is used
for both.
A small bitmap image in the lower-left corner of the Trap/Width pane provides a dynamic
visual example of the selected values.
Specifying Trap Color Reduction
Trap Color Reduction values determine how intense the trapping effect is. The values entered
reflect the percent reduction of the toner in the trap. You can enter values for the following
color channels:
• Cyan: Defines the trap reduction in cyan (0-100%).
• Magenta: Defines the trap reduction in magenta (0-100%).
• Yellow: Defines the trap reduction in yellow (0-100%).
• Black: Defines the trap reduction in black (0-100%).
A 100% reduction results in no toner intensity applied to the trap. A 0% reduction results in
full toner intensity.
When you select the Uniform option, all four Trap Color Reduction values are the same.
If the values were set before you selected Uniform, the highest value is used for all.
A small bitmap image to the left of each color in the Trap Color Reduction pane provides
dynamic visual examples of the selected values.
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Specifying Trap Shape
Trap Shape represents how a single pixel appears when trapped against a contrasting
background. With elements bigger than one pixel, the shape, or part of the shape, is only
visible at the corners of objects. Select any of the following shapes:
• Ellipse
• Diamond
• Rectangle
Specifying Trap Object Types
When no option is selected in the Trap Object Types area, only trapping of objects (text and
graphics) against objects is applied. Select any of the following:
• Trap Objects to Images: Auto trapping is applied to boundary areas between objects
and images.
• Trap Images Internally: Auto trapping is applied to every individual pixel of an image.
This option is available only when you select Trap Objects to Images. If the Trap Objects
to Images option is cleared, the Trap Images Internally option appears dimmed.
Restoring Factory Defaults
Click Factory Defaults to delete all user-defined settings for Auto Trapping and restore the
factory default settings.

Defining custom values for Auto Trapping
Use the following procedure to select the Auto Trapping settings and define custom values.
TO DEFINE AUTO TRAPPING VALUES
1 Start ColorWise Pro Tools and connect to the Fiery EXP50.
2 Click Color Setup.
3 Click the Auto Trapping tab.
4 Define a value for each option in the Auto Trapping pane.

For information about the options in the Auto Trapping pane, see page 63.
5 Click Apply.

The defined Auto Trapping values are applied.
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Printing with the configurable Auto Trapping feature
After you define the Auto Trapping values, print a job with the Auto Trapping feature by
setting the Auto Trapping print option to On from the printer driver. You can change the
setting for this print option using Command WorkStation.
N OTE : If the Auto Trapping values are changed, reRIPping is required to print a job with the

new values.
Use the procedure on page 54 to print a job with custom Auto Trapping values from the
printer driver.
N OTE : Selecting On from the printer driver affects the current job only. Selecting Apply Auto

Trapping in the Auto Trapping pane in Color Setup sets the default value for all jobs, and
allows you to select Printer’s default from the printer driver.
The job is printed with the Auto Trapping values defined in the Auto Trapping pane.

Progressives
The term “Progressives” refers to printing variations in a multi-color document. The
variations may use from one to all of the available color channels in a print device.
The majority of printing processes that involve more than one or two colorants apply the
colorants sequentially. Traditionally, progressives are the intermediate states after some and
before all colorants have been applied. The Progressives feature is more flexible, because it
allows you to select which color is printed, using up to four sheets per original document
page.
N OTE : The Progressives feature is designed to show you the toner separations used by the job

on the print device. The feature is not intended to be used to proof for another non-Fiery
driven print device.
N OTE : Progressives show the separations that the Fiery EXP50 sends to the print device, not

the separations contained in the job source file.
N OTE : Progressives is a “reporting” feature. It is not designed to be used with production

features such as VDP and Imposition. Progressives is offered for diagnostic situations. With
high volume applications or production environments, use Progressives only on the individual
pages that need testing.
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Progressives workflow
You can inspect the result of each channel with the default values for color channels in
Progressives. However, if you must customize the selection of color channels or number of
sheets to print, you can do so by specifying the color channels in the Progressives pane in
Color Setup. After specifying the color channels, print a job with the customized Progressives
by setting the print option to On from the printer driver.
N OTE : You cannot use the Progressives and Postflight features at the same time. A constraint

is set for these print options from the printer driver.
N OTE : Clearing plates in ImageViewer does not have an effect on a Progressives job printed

from ImageViewer. It prints with the values specified in the Progressives pane. For more
information, see “ImageViewer” on page 77.

Printing with default Progressives
Print a job with default Progressives by setting the Progressives print option to On from the
printer driver.
TO PRINT A JOB WITH DEFAULT PROGRESSIVES
1 Choose Print from your application.
2 Select Fiery EXP50 as your printer and click Properties.

The Properties dialog box appears with the Fiery Printing tab selected.
3 Click the Reporting print option bar.

4 Select On from the Progressives list.
5 Click OK.
6 Click Print.

The job is printed with the default Progressives.
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Progressives pane
The settings in the Progressives pane allow you to do the following:
• Specify sheets (1-4) and colors per sheet to print (see the following section).
• Restore the factory default values (see page 68).
Specifying sheets and colors
At least one colorant (Cyan, Magenta, Yellow, or Black) must be selected for each sheet and at
least one sheet must be selected.
Small bitmap images to the left of each row dynamically change to reflect your selections.
Restoring Factory Defaults
Clicking Factory Defaults allows you to delete all user-defined settings for the Progressives
feature and restore the default settings.
Factory default values are set as follows:
•

Sheet 1: Black

•

Sheet 2: Black + Cyan

•

Sheet 3: Black + Cyan + Magenta

•

Sheet 4: Black + Cyan + Magenta + Yellow

These selections are arbitrary, independent of the source job and the printing order of the
digital press. With this selection, the first sheet includes the black plate only, because it is
often the most important plate when looking at separations. The other colors are added in a
“progressive” order.
When you return to the Progressives tab, the set of selections you last made is displayed.
The colors included do not have to represent the actual sequence applied by the digital press,
which provides more flexibility for analyzing the image composition.
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Specifying color channels
Use the following procedure to access the Progressives pane and specify color channels.
TO ACCESS THE PANE AND SPECIFY COLOR CHANNELS
1 Start ColorWise Pro Tools and connect to the Fiery EXP50.
2 Click Color Setup.
3 Click the Progressives tab.
4 Specify the color channels in the Progressives pane.

For information about the options in the Progressives pane, see page 68.
5 Click Apply.

The specified color channels are applied.

Printing with custom Progressives
After specifying the color channels, print a job with custom Progressives by setting the
Progressives print option to On from the printer driver.
N OTE : Alternatively, you can send a job with default Progressives setting and change the print

option setting using Command WorkStation.
Use the same procedure on page 67 to print a job with the custom Progressives feature from
the printer driver. The printed job reflects the Progressives settings you defined in the
Progressives pane.
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Halftone Screens
When proofing, we recommend that you print in contone mode, which uses the best color in
the Fiery system. For advanced proofing purposes, Graphic Arts Package offers user-controlled
halftone generation. Halftoned proofs simulate, with reasonable accuracy, the final dots
imaged on films or plates for offset printing. The halftone screening feature allows you to
define the custom screening functions applied to your print job.

Halftone screens workflow
You can select pre-set halftone screens to print jobs with good results. When you must
customize the values for a halftone screen, define a custom halftone in your application or at
Color Setup, and then select the screen in the Halftone Screen print option from the printer
driver.
For information about the Halftone Screen print option and the procedure to print with the
pre-defined halftone screens, see the following section. For information about the Halftone
Screens pane and the procedure to specify custom halftone screen values, see page 72.

Halftone Screen print option
Access the halftone screening feature through the Halftone Screen print option. Select from
the following option items:
• Printer’s default: Uses the pre-defined device contone, unless a job contains an application
specified halftone screen.
• Application Defined: Uses a pre-defined halftone screen specified in an application.
For information about the supported applications, see page 74.
• Contone: Uses the pre-defined device contone.
• Newsprint: Uses a pre-defined halftone screen that looks and feels like a newspaper.
• User Defined Screen1/2/3: Applies a user-defined halftone screen based on the settings in
Color Setup.
N OTE : The halftone simulation feature screens the data at the native contone device

resolution, which is 600 dpi for the digital press. The simulation is intended to be
approximate for halftoned output. This feature is especially useful for proofing Newsprint
where the contone output may look too smooth compared to the press output at 85 to
120 lpi.
N OTE : Use Newsprint and User Defined Screen1/2/3 with all applications, including

Microsoft Office.
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Printing with pre-defined halftone screens
Use the following procedure to print a job with a pre-defined default halftone screen from the
printer driver.
TO PRINT A JOB WITH A DEFAULT HALFTONE SCREEN
1 Choose Print from your application.
2 Select Fiery EXP50 as your printer and click Properties.

The Properties dialog box appears with the Fiery Printing tab selected.
3 Click the Image Quality option bar.

4 Select a pre-defined halftone screen from the Halftone Screen list.

For more information, see page 70.
5 Click OK to close the Properties dialog box.
6 Click Print.

The job is printed to the Fiery EXP50 with the pre-defined halftone screen.
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Halftone Screens pane
You can define three custom halftone screens on the Halftone Screens pane.

For each of these screens, you can define the following values:
Angle
Type a number (from 0-360) for each color: Cyan, Magenta, Yellow, and Black.
Frequency (LPI)
Type a number for each color: Cyan, Magenta, Yellow, and Black. Select the check box
next to the link icon to make the values for Frequency (LPI: lines per inch) the same for all
four channels. Frequency refers to the number of rows of spots that combine to form a
halftone dot.
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Dot Shape
Select a PostScript function for dot shape. When you select Custom, the Dot Shape dialog
box appears. This dialog box provides a text field in which you type a PostScript function.
When this dialog box first opens, it reflects the last custom-defined dot shape.

Setting a custom Halftone Screen
Use the following procedure to access the Halftone Screens pane and specify a custom
halftone screen.
TO SPECIFY A CUSTOM HALFTONE SCREEN
1 Start ColorWise Pro Tools and connect to the Fiery EXP50.
2 Click Color Setup.
3 Click the Halftone Screens tab.
4 Specify the angle, frequency, and dot shape for a custom halftone screen.

For information about the options on the Halftone Screens pane, see page 72.
5 Click Apply.

The specified settings for Angle, Frequency, and Dot Shape are applied to the custom
halftone screen.

Printing a job with custom Halftone Screens
After specifying the halftone screen values for User Screen 1, User Screen 2, or User Screen 3,
select a corresponding custom screen name from the printer driver. Use the same procedure
on page 71 to print a job with a custom halftone screen.
N OTE : Alternatively, you can send a job with a default halftone screen and change the print

option setting using Command WorkStation.
The printed job reflects the settings you defined on the Halftone Screens pane.
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Supported applications
The following applications have been tested with Mac OS and Windows for compatibility
with the Application Defined setting in the Halftone Screen print option. Other applications
should work as well, as long as they are using standard PostScript conversions on halftone
screen definitions and the parameters used in the definitions are kept within the physical
limitations of the digital press.
• Adobe Acrobat 6
• Adobe Illustrator 8, 9, and 10
• Adobe InDesign 1.5, 2, and CS
• Adobe PageMaker 6.5 and 7
• Macromedia FreeHand 9, 10, and MX
• QuarkXPress 4.1, 5, and 6

Calibrating for custom halftone screens
When color quality is important, make sure that the Fiery EXP50 is calibrated for the
particular halftone screen you use. Changing a halftone screen usually modifies the color
response of the digital press.
The best color is achieved when an Output profile that is associated with the appropriate
calibration response is selected at print time. However, when custom halftones are specified,
the Fiery EXP50 does not have adequate information about the resulting color response.
For this reason, achieving good color with custom halftone screens is often possible only when
you perform custom halftone calibration and use a profile based on this custom halftone.
Use the following procedure to calibrate the Fiery EXP50 for custom halftone screens.
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TO CALIBRATE THE FIERY EXP50 FOR CUSTOM HALFTONE SCREENS
1 Prepare the measurement instrument you use for calibration.

For information about supported measurement instruments, see Color Printing.
2 On the User Software DVD, open the folder that contains the custom halftone calibration files.

The folder locations for Macintosh and Windows are as follows:
Mac OS: Mac Color Files:Calibration Files:Halftone Calibration Files:Photoshop or Other

Applications
Windows: Windows Color Files\Calibration Files\Halftone Calibration Files\Photoshop or

Other Applications
The folder contains images of the measurement pages for various instruments and page sizes.
If you print halftone screens only from Adobe Photoshop, open the Photoshop folder;
otherwise, open the Other Applications folder.
N OTE : When opening or printing these files, never “color-manage” using PostScript Color

Management or ICC profiles that provide color conversions.
3 From Photoshop, open the image file that corresponds to your instrument and page size.
From other applications, open a blank document and place the EPS file that matches your
instrument and page size.

The images were prepared for the final sheet page size. If you are placing an image, do so using
no margins. Ignore warnings that the image may be clipped.
N OTE : If you use these measurement pages with the Fiery EXP50 standard screens, make sure

to properly set the PPD print option that controls the screen.
4 Print the measurement page using your custom halftone and other print option settings.

This page is now the custom calibration measurement page.
You must print this measurement page with the CMYK Simulation Profile print option set to
ColorWise Off, which produces an uncalibrated page.
N OTE : To calibrate your digital press, you must print CMYK patches in the raw state of the

printer. Except for the Output Profile print option, the ColorWise print options are irrelevant
and will be ignored.
To increase the speed and reliability of the calibration, print your measurement page, with the
appropriate print option settings, to a PostScript file. The next time you calibrate, download
this PostScript file. Retaining this file in the Hold queue of the Fiery EXP50 makes the entire
calibration process even faster.
5 With ColorWise Pro Tools Color Editor, open any Output profile.
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N OTE : You can select any Output profile because you will be printing the measurement page

with the CMYK Simulation Profile set to ColorWise Off. With this setting, color conversions
using an Output profile will not occur.
For information about Color Editor, see ColorWise Pro Tools Help.
6 Save this Output profile under a new name descriptive of your custom halftone screen.
7 Use ColorWise Pro Tools Profile Manager to associate this Output profile with an appropriate
Calibration Set.

Even though the CMYK Simulation Profile print option is set to ColorWise Off, it is
important to associate the appropriate Calibration Set to the Output profile because its
measurement is used for calibration.
For information about Profile Manager, see ColorWise Pro Tools Help.
8 Use ColorWise Pro Tools Calibrator to perform the calibration.

N OTE : Do not use the Print button to generate the measurement page in Calibrator. Use the

measurement page that you printed in step 4.
For information about Calibrator, see Color Printing.

Using Color Profiler for custom halftone screens
For optimal color, creating a custom profile may also be necessary. Even though you must
calibrate often (once a day), you need to perform the following custom profile creation only
once.
TO CREATE A PROFILE FOR A CUSTOM HALFTONE SCREEN
1 Calibrate the printer using the previous procedure.
2 Use Color Profiler to print the calibration measurement page with the same halftone screen
setting that you used to calibrate.

N OTE : Color Profiler is provided as an option.
N OTE : Use the same Output profile as the one that was saved in calibration, and print the

Profiler patches with the CMYK Simulation Profile print option set to None.
3 Use ColorWise Pro Tools Profile Manager to set the profile that was saved as the System
Default profile during calibration.

This is necessary because downloaded profiles take their calibration targets from the System
Default profile.
4 Download the profile you just created to the Output area.

Make this profile the new default. Verify that it is associated with the Calibration Set that
applies to your custom halftone.
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IMAGEVIEWER
ImageViewer allows you to soft proof and adjust colors in a job before it is printed. You can
use the preview in ImageViewer to verify job placement, orientation, and content, as well as
general color accuracy. If the job contains halftone screened settings, the preview shows a
composite view of all separations at the dot level. You can select to display the plate data for
each process color independently or in combination with the other colors, allowing inspection
of individual plate data or a combination of any range of plates.

Accessing ImageViewer
Start ImageViewer from either the Actions menu or Preview window of Command
WorkStation.
TO START IMAGEVIEWER FROM THE ACTIONS MENU
1 In the Active Jobs window of Command WorkStation, select the job that you want to preview.

N OTE : ImageViewer recognizes only jobs that show processed/held (dark yellow) status.

Processed/held jobs are also indicated by the raster job icon (page icon ringed with a halo).
2 If needed, choose Process and Hold from the Actions menu to move the job to processed/held
status.
3 To start ImageViewer, do one of the following:

• Choose Launch EFI ImageViewer from the Actions menu.
• Right-click the selected job and choose Launch EFI ImageViewer from the menu that
appears.
The ImageViewer main window appears.
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TO START IMAGEVIEWER FROM THE PREVIEW WINDOW
1 In the Active Jobs window of Command WorkStation, select the job that you want to preview.

N OTE : ImageViewer recognizes only jobs that show processed/held (dark yellow) status.
2 If needed, choose Process and Hold from the Actions menu to move the job to processed/held
status.
3 Choose Preview from the Actions menu.

Page thumbnails appear in the Preview window.

1

Click for full-screen preview

1

4 To start ImageViewer, do one of the following:

• Select the thumbnail of the page that you want to soft proof, and click the Full-Screen
Preview button.
• Double-click the thumbnail of the page that you want to soft proof.
The ImageViewer main window appears.
For information about using the ImageViewer application, see ImageViewer Help.
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SOFT PROOFING
The Soft Proofing feature allows you to view accurate color previews of print jobs on a
monitor. Use soft proofs to preview colors as they will appear when the job is printed.
N OTE : Access Soft Proofing through Command WorkStation.

Viewing soft proofs
The Soft Proofing feature applies a specified color profile to the preview of a job to
compensate for the unique display characteristics of your monitor. As a result, the preview
provides a more accurate representation of how the job will appear when printed.
TO VIEW A SOFT PROOF OF A JOB
1 In the Active Jobs window of Command WorkStation, select the job that you want to
soft proof.

Soft Proofing is supported only for jobs that show processed/held (dark yellow) status.
2 If needed, choose Process and Hold from the Actions menu to move the job to processed/held
status.
3 Choose Preview from the Actions menu.

Page thumbnails appear in the Preview window.

1

Click for full-screen preview

1
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4 Select the thumbnail of the page that you want to soft proof, and click the Full-Screen
Preview button.

The full-screen preview may take a few moments to open. The full-screen preview window is
independent of and may appear behind the application on the screen. Bring the full-screen
preview window to the front, if necessary.

1

Soft-Proof option

1

5 Select the Soft Proof option.

A dialog box prompts you to select a monitor profile.

81

SOFT PROOFING

6 Locate and select the monitor profile for your monitor.

Be sure to select a profile customized for the characteristics of your monitor. Otherwise, the
soft proof will not be accurate. Also, be sure to configure the monitor display according to the
manufacturer’s recommended settings. For information about monitor profiles, see page 16.
7 Click Open.

The full-screen preview displays a soft proof of the original job, as interpreted through the
monitor profile you specified.
8 To change the monitor profile used for the soft proof, click the Load button next to the
profile name in the full-screen preview window.

1

Click to change profiles

1

In the dialog box that appears, locate and select the new monitor profile, and then click Open.
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PREFLIGHT
The preflight feature performs a simple check of the most common areas of error to ensure
that the job will print successfully and to the expected quality on the selected printing device.
Access the Preflight feature from Command WorkStation. For more information about
Command WorkStation, see Utilities and Command WorkStation Help.

Setting Preflight options
Before performing the preflight check on your job, specify the following preflight checks and
notification levels.

Setting preflight checks
You can set preflight checks for the following:
• Fonts: When missing and When substituted
• Spot Colors: When missing
• Low-Res Images: When image resolution is less than specified dpi
• VDP Resources: When not found
You can select individual VDP resources to Preflight.
• Hairlines: When line width is less than specified point size
• Overprint: When overprint is detected
• Postscript: When any PostScript error is found
• Halt preflight on first error: When any error is found

Setting notification levels
For each preflight category, you can specify a notification level:
• Critical: marks any errors with a Critical icon (

).

• Warning: marks any errors with a Warning icon (
• Message: marks any errors with a Message icon (

).
) and provides information.

• Ignore: skips check of that category.
A category with no errors is marked with a Pass icon (

).

PREFLIGHT

Using Preflight
The following file formats are supported for preflight:
• PostScript
• Adobe Acrobat PDF
• EPS
• PPML
• VIPP
N OTE : TIFF and PCL files are not supported for Preflight checks.

Use the following steps to preflight a job.
TO PREFLIGHT A JOB
1 Select a spooled/held job in the Active Jobs window, and choose Actions>Preflight.
2 Set a notification level for each error or use the default Preset.
3 Click Save to save the settings as a new preset if you want to use them again.
4 Click Preflight to perform the Preflight check.
5 Click Save to save the report as a PDF.
6 Click Print Report to print the report.
7 Click Preflight Again to repeat the preflight check.
8 Click Close to exit Preflight.
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HOT FOLDERS FILTERS
This chapter describes how to configure the Hot Folders filters to convert various files
to PostScript or PDF (Portable Document Format), or to preflight certain files.
For information about operating systems that support Hot Folders, see Welcome.
For information about installing the Hot Folders application, see Utilities.
For information about using the Hot Folders application, see Hot Folders Help.

About file conversion
Hot Folders filters allow you to convert certain file formats to PostScript or PDF or to
preflight files for conformity. File conversion and preflighting take place on your computer
within Hot Folders, which saves Fiery EXP50 resources. You can print files directly from Hot
Folders filters without starting the application from which they were created.
Two types of filters are available: Exclusive and Non-exclusive. A Hot Folder configured with
an Exclusive filter processes the defined file type(s). No other file formats, including the
default file formats, are processed. When you select an Exclusive filter, you disable all other
filters.
Non-exclusive filters allow Hot Folders to accept multiple default file formats, such as
PostScript, PDF, TIFF, and EPS. Non-exclusive filters can also be used with other
Non-exclusive filters.
When you configure an Exclusive filter to a Hot Folder, the Hot Folder icon changes, and is
renamed to reflect the Exclusive filter.
1
2
3
4

Hot folder with Exclusive
filter (Windows)
Standard Hot Folder
(Windows)
Hot Folder with Exclusive
filter (Mac OS)
Standard Hot Folder (Mac OS)

1

2

3

4
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Filters
The following table describes the available filters and indicates whether the filter is Exclusive
or Non-exclusive:
Filter name

Type of filter

Description

See

CT/LW to PostScript

Exclusive

Converts multiple CT (Contone), LW (Line Work), or FP (Final Page)
files into a single combined PostScript file.

page 88

CT/LW files are files that contain information about photographic
imagery, line art images, or text and lines from drawings. Together, CT
and LW files determine the final output that will appear.
DCS 2.0 to PostScript

Exclusive

Converts DCS 2.0 files to pre-separated PostScript files, with one
separation per page.

page 89

Developed by QuarkXPress, the DCS 2.0 file is a picture format
definition for electronic color separations.
This filter accepts:
Single/Multiple file DCS, no composite
Single/Multiple file DCS with grayscale composite
Single/Multiple file DCS with color composite
EPS to PostScript

Exclusive

Converts EPS files to PostScript files and provides options for scaling and page 89
positioning the output.

ExportPS

Exclusive

Processes ExportPS files and converts them to PostScript or PDF files.

page 91

Developed by Creo-Scitex, the ExportPS file is a PostScript raster output.
JPEG to PDF

Non-exclusive

Converts JPEG files to PDF files and provides options for scaling and
positioning of the output.

page 91

PDF to PostScript

Non-exclusive

Converts PDF files to PostScript files.

page 91

PDF/X Preflight

Exclusive

Indicates if the PDF job meets PDF/X specifications.

page 93

This filter allows PDF/X-1a or PDF/X3-compliant jobs to be
downloaded to the Fiery EXP50.
PDF2Go

Exclusive

Processes PDF2Go files and converts them to PostScript or PDF files.

page 94

Developed by Creo-Scitex, the PDF2Go file is a PDF output that
contains PDF layers or rasterized CT and LW, each with a different
resolution.
TIFF to PDF

Non-exclusive

Converts TIFF files to PDF files and provides options for scaling and
positioning of the output.

page 94

This filter accepts all TIFF files up to TIFF 6.0.
TIFF/IT to PostScript

Exclusive

Converts TIFF/IT files to preseparated PostScript files, with one
separation per page.
TIFF/IT-p1 is a common file format for the transfer of final print job
data from one print platform to another. It is a widely used format for
prepress preparation in traditional printing environments.

page 96
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Specifying filter settings for a Hot Folder
After specifying the filter settings and options for your Hot Folder, drag and drop the proper
file formats onto your Hot Folder to begin the conversion process.
Open the Filter Settings dialog box from the Folder Properties dialog box.
TO SELECT A FILTER SETTING
1 From the Hot Folders Control Panel, select the Hot Folder and click Properties.
2 Select Filter Settings and click Define.

The Filter Settings dialog box appears, allowing you to select the filter and configure
the settings.

For Windows, filters are color-coded. Exclusive filters are blue and Non-exclusive filters are
black. For Mac OS, Exclusive and Non-exclusive filters are indicated after the filter type
names.
3 Select the filter that you want to use for the Hot Folder.

If you select an Exclusive filter, you cannot select any other filter.
4 Right-click or double-click the filter name and select Properties.

For more information, see “Using the filters” on page 88.
5 To convert all PostScript files to PDF automatically, select Convert PS to PDF and a job option
from the Distiller Profile menu in the PS->PDF Normalizer pane.

For information about PS->PDF Normalizer, see the following section.
6 Click OK.
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About PS->PDF Normalizer
The PS->PDF Normalizer feature offers the Convert PS to PDF option.
N OTE : The Convert PS to PDF option is available only when Adobe Acrobat Distiller is

installed on the same system as the Hot Folders application. For more information about
installing Acrobat Distiller, see Utilities.
Convert PS to PDF
Although many filters output PostScript by default, this option allows you to further convert
PostScript to PDF. This is a global setting that affects all PostScript files for a particular Hot
Folder. This setting affects all PostScript output from all filters.
Since Convert PS to PDF affects all PostScript output files, turning on this setting may not be
suitable in certain printing workflows.
For example: Both the DCS 2.0 and TIFF/IT filters output pre-separated PostScript files, one
separation file per page. In order to print these pre-separated files as a composite image, you
must select the Combine Separation option in the Job Settings. However, the Combine
Separation feature accepts only the PostScript type files. Selecting the Convert PS to PDF
option results in printing multiple grayscale pages, instead of a composite color page of an
image.
Distiller Profile
This menu displays all the available Distiller job options. This setting is used to control the
quality of the PostScript to PDF conversion. The Hot Folders application retrieves the job
options from the location set by Distiller. If you create and save your custom Distiller job
options elsewhere, the custom job options must be manually copied to the Distiller\Settings
folder.
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Using the filters
Certain filters provide extra user control and conversion settings. To access these settings,
right-click or double-click the Plugin Name in the Filter Settings dialog box.
This section describes each filter and its optional settings.
N OTE : The procedures for using the filters from a Mac OS or a Windows computer are

similar. The following procedures use illustrations from a Windows computer.

Using the CT/LW to PostScript filter
The CT/LW filter accepts multiple CT (Contone) and LW (Line Work) files and an FP (Final
Page) file. It determines the page dimensions of the combined file based on the FP, LW, and
CT files, in that order. Spot colors are converted to process CMYK using conversion values
specified in the CT/LW files. The combined file is a single RLE compressed CMYK image,
and you can specify the resolution.
When you drag and drop your CT, LW, or FP files, your output is a single PostScript file.
N OTE : Some CT/LW files may include a “.” (period) at the beginning of the file name,

indicating that they are hidden files. Make sure that you turn on Show Hidden Files in your
folder settings. For more information, see the documentation that accompanies your system.
In order to ensure that all files, including hidden files, are copied and processed, drop the
entire CT/LW page folder containing all the necessary files.
TO USE THE CT/LW TO POSTSCRIPT FILTER
1 Follow steps 1 through 4 in “To select a filter setting” on page 86.

The CT/LW Filter Options dialog box appears.

2 Select the final resolution (Auto, 200, 400, or 600) for your image.

N OTE : Select Auto to use the device resolution of the digital press.
3 Click OK.
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Using the DCS 2.0 to PostScript filter
The DCS 2.0 (Desktop Color Separation) to PostScript filter accepts DCS 2.0 files and
outputs a single preseparated PostScript file.
This filter accepts the following DCS 2.0 files:
• Single/Multiple DCS files, no composite
• Single/Multiple DCS files with grayscale composite
• Single/Multiple DCS files with color composite
The DCS 2.0 filter has no configurable options; however, you must follow these guidelines to
convert your DCS 2.0 job:
• Enable the Combine Separations print option. For more information about setting print
options, see Print Options.
• Make sure that you have necessary multiple files for a DCS 2.0 job and in one folder.
If a file is missing, the filter fails to process and an error message appears.
• If multiple files for a DCS 2.0 job are stored in a folder, you may place the entire folder in
the Hot Folder.
• If you download a DCS 2.0 job using the Download command, all files may be inside a
folder. You must download the entire folder.
N OTE : If you configure the DCS 2.0 to PostScript filter, the Imposition feature is not

available.

Using the EPS to PostScript filter
The EPS to PostScript filter accepts all EPS files. This filter gives you the flexibility to force
changes in the final dimensions and page size of a file.
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TO USE THE EPS TO POSTSCRIPT FILTER
1 Follow steps 1 through 4 in “To select a filter setting” on page 86.

The EPS to PostScript Filter Options dialog box appears.

2 Specify the following options:
Scale Image Width and Height To: Select this option to scale all EPS files to the desired image

size. Select inches or millimeters from the list, and then specify the values.
PS Page Size: Select this option to print all EPS files to the page size that you specify. Select a

page size from the list or click Custom and specify a custom page size in the Enter Custom
Paper Size dialog box.
When this option is selected, you can:
• Ignore unprintable margins to print the image to the entire page size.
• Shrink oversized images to fit proportionately.
• Expand small images to fit proportionately.
• Automatically rotate images to the page orientation.
• Set the position of the image to Top-Left, Top-Right, Center, Bottom-Right, or
Bottom-Left.
3 Click OK.
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Using the ExportPS filter
ExportPS was developed by Creo-Scitex as an option to their Brisque print workflow.
ExportPS translates Brisque jobs into portable, raster PostScript or EPS output that can be
processed on the digital press.
The ExportPS filter processes the ExportPS file by rendering and resampling it to the
resolution of the digital press. You can select the output to be PostScript or PDF.
TO USE THE EXPORTPS FILTER
1 Follow steps 1 through 4 in “To select a filter setting” on page 86.

The ExportPS Filter Options dialog box appears.

2 Specify the following options:
Output (PS or PDF): Select the final output.
Resolution (Auto, 200, 400, or 600): Select the final resolution of the output. Select Auto to

use the device resolution of the digital press.
3 Click OK.

Using the JPEG to PDF filter
The JPEG to PDF filter accepts all standard JPEG files. In addition to allowing you to convert
JPEG files automatically without opening them from the application from which they were
created, the JPEG to PDF filter allows you to change the final page size of print jobs and
adjust the resolution.
This filter is Non-exclusive, so you can download basic file formats. For more information
about Non-exclusive filters, see “About file conversion” on page 84.
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TO USE THE JPEG TO PDF FILTER
1 Follow steps 1 through 4 in “To select a filter setting” on page 86.

The JPEG to PDF Filter Options dialog box appears.

2 Specify the following options:
Scale Image Size To: Select this option to scale all JPEG files to the desired image size or
resolution. Select Width and Height, select inches or millimeters from the list, and specify the
values for the image size. Select Resolution, select pixels/inch or pixels/cm from the list, and
specify the value for the resolution.
PDF Page Size: Select this option to print all JPEG files to the page size that you specify. Select

a page size from the list or click Custom and specify a custom page size in the Enter Custom
Paper Size dialog box.
When this option is selected, you can:
• Shrink oversized images to fit proportionately.
• Expand small images to fit proportionately.
• Automatically rotate images to the page orientation.
• Set the position of the image to Top-Left, Top-Right, Center, Bottom-Right, or
Bottom-Left.
3 Click OK.
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Using the PDF to PS filter
The PDF to PS filter accepts PDF files and outputs PostScript files.
N OTE : This filter converts all files to PostScript Level 3 files.

Using the PDF/X Preflight filter
PDF/X (PDF Exchange) Preflight is a subset of Adobe PDF designed specifically for prepress
data interchange. It defines how applications that read and create PDF/X files should behave.
Two PDF/X standards are commonly used:
• PDF/X-1a standard: This standard addresses blind exchanges to verify that files contain
only CMYK (and/or spot colors), with no RGB or device independent (color-managed)
data.
• PDF/X3: This standard meets all the requirements of a PDF/X-1a, but contains device
independent (color-managed) data.
The PDF/X Preflight filter allows you to verify that a PDF document is PDF/X-compliant
with either the PDF/X-1a or PDF/X3 standard. If the PDF file is not PDF/X-compliant, the
job fails to process and an error report appears.
TO USE THE PDF/X PREFLIGHT FILTER
1 Follow steps 1 through 4 in “To select a filter setting” on page 86.

The PDF/X Preflight Options dialog box appears.

2 Specify the following options:
Specifications (PDF/X-1a or PDF/X3): Select to verify PDF/X-1a or PDF/X3 compliance.
Save Error Report: Select to generate an error report for failed jobs.
Error Report Path: Browse to select an error report location.
3 Click OK.
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Using the PDF2Go filter
PDF2Go is a PDF output developed by Creo-Scitex as an option to their Brisque workflow.
It usually contains PDF layers of rasterized CT and LW job pages, each with a different
resolution, in one PDF file.
The PDF2Go filter processes the PDF2Go file by rendering and re-sampling it to the
resolution of the digital press. You can select PostScript or PDF output.
TO USE THE PDF2GO FILTER
1 Follow steps 1 through 4 in “To select a filter setting” on page 86.

The PDF2Go Filter Options dialog box appears.

2 Specify the following options:
Output (PS or PDF): Select the final output.
Resolution (Auto, 200, 400 or 600): Select the final resolution of the output. Select Auto to

use the device resolution of the digital press.
3 Click OK.

Using the TIFF to PDF filter
The TIFF to PDF filter accepts TIFF files up to TIFF 6.0. In addition to allowing you to
convert TIFF files automatically without opening them from the application from which they
were created, the TIFF to PDF filter allows you to change the final page size of print jobs and
adjust the resolution.
This filter is Non-exclusive, so you can download basic file formats. For more information
about Non-exclusive filters, see “About file conversion” on page 84.
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TO USE THE TIFF TO PDF FILTER
1 Follow steps 1 through 4 in “To select a filter setting” on page 86.

The TIFF to PDF Filter Options dialog box appears.

2 Specify the following options:
Scale Image Size To: Select this option to scale all TIFF files to the desired image size or
resolution. Select Width and Height, select inches or millimeters from the list, and specify the
values for the image size. Select Resolution, select pixels/inch or pixels/cm from the list, and
specify the value for the resolution.
PDF Page Size: Select this option to print all TIFF files to the page size that you specify. Select

a page size from the list or click Custom and specify a custom page size in the Enter Custom
Paper Size dialog box.
When this option is selected, you can:
• Shrink oversized images to fit proportionately.
• Expand small images to fit proportionately.
• Automatically rotate images to the page orientation.
• Set the position of the image to Top-Left, Top-Right, Center, Bottom-Right, or
Bottom-Left.
3 Click OK.
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Using the TIFF/IT to PostScript filter
TIFF/IT (Tagged Image File Format/Image Technology) is a common TIFF standard. The
TIFF/IT-p1 file format usually consists of three files. All TIFF/IT-p1 files contain an FP (Final
Page) file. The FP file includes page dimension and position required subfiles, such as CT
(Contone) and LW (Line Work) files. CT files contain all photographic imagery. LW files
contain high resolution data, such as line art images, text, or lines from drawings.
TIFF/IT-p1 files may also include MP (Monochrome Picture), HC (High resolution
Contone), BL (Binary Line), or BP (Binary Picture) files.
When you drag and drop your TIFF/IT-p1 files, your output is a pre-separated PostScript
with one separation per page.
Follow these guidelines to convert your TIFF/IT-p1 job:
Enable the Combine Separations print option. For more information about setting print
options, see Print Options.
• Make sure that you have all the necessary files for the TIFF/IT-p1 job. You must place all
of the files in the Hot Folder at the same time. If there is a file missing, the job will not
process and you will receive an error.
• If the multiple files for the TIFF/IT-p1 job are stored in a folder, you may place the entire
folder in the Hot Folder.
• If you download the TIFF/IT-p1 job using the Download command, all files may be inside
a folder and the entire folder may be downloaded.
N OTE : The imposition feature is not available if you configure the TIFF/IT to PostScript filter.
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TO USE THE TIFF/IT TO POSTSCRIPT FILTER
1 Follow steps 1 through 4 in “To select a filter setting” on page 86.

The TIFF/IT Filter Options dialog box appears.

2 Specify the following options:
Resolution (Auto, 200, 400, or 600): Select the final resolution of the PostScript output from
the list. Select Auto to use the device resolution of the digital press.
Compression (None or RLE Lossless): Select if you want compression for your PostScript

output.
Anti-Aliasing (Nearest Neighbor Faster or Bilinear Better): Select how you want to partially
fill the edge pixel by choosing the Anti-Aliasing method for your PostScript output.
3 Click OK.
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POSTFLIGHT
The Postflight feature helps you determine why some printed jobs may not deliver expected
color. Acting as a diagnostic and training tool for all users, it provides helpful global and
object-specific information about how a job is actually received and processed by the
Fiery EXP50.
Use Postflight to troubleshoot color problems with a previously printed job or as a preventive
measure. You can print the original document (or RIPped and previewed) with all objects
(images, graphics, and text) color-coded. A report explains what color spaces are used in the
job and what print options affect those spaces. The report also provides information about the
printing environment, such as calibration date, time, and method. Print a Test Page to verify
the condition of the printing environment.
Postflight is a powerful analysis tool that enumerates in its reports not only those color spaces
that are used by visible objects, but any color space called by a job. This can be very useful in
diagnosing puzzling situations that may require correction. For example: using one specific
combination of a printer driver, an OS, and a desktop publishing application emitting
separations for plates, you might find that: 1) the Postflight color-coded pages show the Cyan,
Magenta, and Yellow separations in the “DeviceGray” color space, while the Black separation
is shown in the “DeviceCMYK” color space; 2) the Postflight report enumerates: DeviceGray,
DeviceCMYK and DeviceRGB. What once required a PostScript expert to decipher can now
be interpreted in minutes using Postflight reports: the Cyan, Magenta, and Yellow pages are
defined in “DeviceGray”, the Black page is using the “K” channel of DeviceCMYK, and the
job is calling for the RGB color space, without applying it on any user-visible object.
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About Postflight
When the Postflight print option is set to values other than Off, it provides the following
information to help you identify possible problems: Postflight Test Page, Postflight colorcoded pages, and Postflight reports.

Postflight Test Page
You can print the Postflight Test Page alone or in combination with the color-coded pages.
The Test Page is printed using the exact same media and global settings (such as calibration) as
your job. However, color objects on this page are printed independently of the user-specified
source color definitions (such as CMYK simulation and RGB).
If the color on this page is not accurate, the problem lies with the printing environment (such
as the calibration, output profile, or print device).
If the color on this page prints correctly but objects in your job do not print in expected
colors, it is likely that the problem lies with the color setting specific to these objects.
Problems with objects can be: wrong color values for text and graphics, bad quality images, or
out-of-gamut colors.

Postflight color-coded pages
With this option, Postflight prepares a color-coded version of the original document that
displays each object with a color corresponding to the color space that the Fiery EXP50
received for the object.
The colors used to represent the color spaces for objects are as follows:
• Gray objects: Gray
• CMYK objects: Cyan
• RGB objects: Red
• Device-Independent objects: Indigo
• Spot color objects: Yellow
By reviewing the colors for all objects, you can identify the print option settings that affect the
color conversion of the objects and make appropriate modifications.
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Postflight reports
You can print two types of reports on color-coded pages, either alone or combined with the
color-coded document. These reports are printed on the Fiery EXP50 default paper size
(Letter for US, A4 for metric) and use the default calibrated color mode.
Select the Postflight report from the following two types:
• Detailed Report includes detailed static information with advice on possible procedures
and values. An icon identifies the “detailed” information areas of the report.
• Concise Report includes only job-specific information. This option is good for advanced
users who do not want the instructions which may seem redundant to them.
Detailed and Concise Reports
The reports provide a document header with information (such as job name, date and time
printed, and user name), a ColorWise global settings page, and object-specific settings pages.
All pages include the job name, postflight date/time, and pagination in the bottom margin.
• ColorWise global settings page provides information that affects every object in a job, such
as Calibration Set, the date the Fiery EXP50 was calibrated, the method used for
calibration, and the output profile that was used.
• Object-specific settings pages provide a list of the settings that were used to process every
object in each color space, thus suggesting the locations to correct problems. For example,
if you see a problem with an object that is displayed in Cyan in a color-coded page, review
the settings listed in the CMYK Objects page and try changing those settings.
• Spot colors page lists all spot colors.
For spot colors, the Postflight report lists the colors that are used in a job. It also indicates
whether these colors are defined in the Fiery EXP50. When a spot color is defined in the
Fiery EXP50, a patch is printed next to the color name. When a color is not defined in the
Fiery EXP50, a white patch with an X is printed.
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Important notes on Postflight reports
The main purpose of Postflight is to help you detect, diagnose, and prevent color-related
problems. In contrast to generic preflight software, which attempts to predict how a job
would be processed, a postflighted job is fully processed by the Fiery EXP50, allowing
accurate reporting on the settings with which the job processed.
This Postflight feature is especially useful in cases where a workflow that was used to submit a
job inadvertently converts colors. This conversion occurs with some printer drivers, printing
options, and conversions to PDF.
This report focuses on color processing and does not list every printing option that affects
your job. For more information about the ColorWise print options, see Color Printing.
N OTE : Postflight reports list only those color spaces that were submitted to the Fiery EXP50

with your job. You may occasionally find that a job produces a Postflight report that includes
information about color spaces that you cannot locate in the job’s color-coded pages. This
occurs when an object in the color space is used in the job but is masked by another object,
when an object is very light (for example, 0% of a spot color), or when the specific application
or printer driver asks the Fiery EXP50 to process a particular color space but does not use it
for user-visible objects.
N OTE : A Postflight report contains only one page on global settings, and it can include only

one Test Page; therefore Postflight cannot describe an entire job accurately unless all pages are
printed with the same options and on the same media. This is the case, for instance, with
Mixed Media jobs, because they can use multiple output profiles, up to one profile per media
in the job. If the page range is set to the pages that use one media only, Postflight produces
reliable results for the specified range.
N OTE : Postflight is a “reporting” feature that is designed for diagnostic purposes. It is not

designed for use with production features such as VDP and Imposition. For high-volume
applications in production environments, use Postflight only on the individual pages that
need testing.
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Postflight print option
Access the Postflight feature through the Postflight print option. You can select a single
component or all components for the Postflight information.
The following values are available for the Postflight print option:
• Off (Default)
• Detailed Report Only
• Concise Report Only
• Test Page Only
• Color-Coded Pages Only
• All Components (Color-Coded document pages, Test Page, and Detailed Report)
N OTE : Select a portion of a job to print the Postflight pages by selecting the appropriate page

range of a job from the printer driver.

Postflight workflow
The default settings in the ColorWise print options are such that in most cases you should not
have to change them. However, there may be times when you receive unexpected colors for
your job. Postflight is a procedure performed after you print a document and receive
unexpected or inadequate color. If you have access to Command WorkStation, Postflight also
helps you catch color problems before you actually print. Postflight processes your job and
collects information about the color objects throughout. The information is then displayed in
Color-Coded document pages, a Test Page, and a Detailed or Concise Report.
N OTE : The background defined in the Paper Simulation is not indicated as a CMYK object in

the Postflight reports. For more information about Paper Simulation, see page 17.
N OTE : You cannot use Postflight at the same time that you use the following feature:

Progressives, Substitute Colors, or Combine Separations. Constraints are set for these print
options from the printer driver.
The follows scenarios show how Postflight can be helpful to users who demand high color
quality.
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To diagnose an unexpected color (see page 104)
Use Postflight to diagnose unexpected color in a job, or determine which printing or
calibration settings apply to a job.
To check the calibration status prior to printing a job (see page 106)
Consider the following before printing a job:
• The Fiery EXP50 may include many Calibration Sets. Which Calibration Set applies to
my job?
• When was the Fiery EXP50 last calibrated?
• Which instrument was used for the last calibration?
To check the quality of the output profile (see page 107)
If you are considering using a new paper for which you do not have a custom profile, or if you
suspect that the output profile for your print device may not precisely describe its color
behavior, check your output profile by printing the Postflight Test Page.
To diagnose a color problem of a specific object (see page 108)
When experts have verified that the calibration is correct and that the global settings,
including the output profile, are correct, but the color of a specific object is still not as
intended, you can print a color-coded document and diagnose the problem.
The detailed procedures of these scenarios are described in the following sections.
N OTE : For each of the following procedures, instead of printing the report to the

Fiery EXP50, you can also send it to the Hold queue of the Fiery EXP50 and preview the
information (of a job with raster data) in ImageViewer. For more information about
ImageViewer, see “ImageViewer” on page 77. To view the color of a job correctly, you must
set your monitor and monitor profile correctly. For more information about the monitor and
monitor profiles, see page 16.
N OTE : The procedures for printing a job from a Windows and a Mac OS computer are

similar.
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Scenario 1: Diagnose an unexpected color
Use the following procedure to print a job with Postflight set to Off.
TO PRINT A JOB
1 Open a job from your application.
2 Choose Print.
3 Select Fiery EXP50 as your printer and click Properties.

The Properties dialog box appears with the Fiery Printing tab selected.
4 Click each option bar, and specify the values for the print options.

5 Click the Reporting print option bar.

6 Select Off from the Postflight list.
7 Click OK to close the Properties dialog box.
8 Click Print.

The job is printed to the Fiery EXP50.
After you print a job, use the following procedure to diagnose an unexpected color and print
the job with edited color settings.

POSTFLIGHT

105

TO DIAGNOSE AN UNEXPECTED COLOR AND PRINT WITH EDITED COLOR SETTINGS
1 Click the Reporting print option bar.
2 Select All Components from the Postflight list.

For information about the components of Postflight, see page 99.
3 Click OK to close the Properties dialog box.
4 Click Print.

Postflight Test Page, color-coded document pages, and Postflight Reports are printed.
5 Review all Postflight pages.

For information about the Postflight pages, see page 99.
6 Make appropriate changes based on all Postflight pages.

For more information about the changes, see the following section.
7 Select Off from the Postflight list.
8 Click OK.
9 Click Print.

The job with the edited color settings is printed to the Fiery EXP50.
10 Return to Step 1, if needed.

Repeat the steps until you get the satisfactory color results.
Making changes
After reviewing the Postflight information, determine what changes are necessary and apply
the changes. Depending on your printing environment, the condition of the print device, and
the color settings, possible changes are as follows:
• Correct problems with the print device (see the documentation that accompanies the
print device).
• Calibrate the Fiery EXP50 (see Color Printing).
• Edit the colors of the output profile with Color Editor (see Color Printing).
• Change the default settings in the Color Process Flow tab in Color Setup (see Color
Printing).
• Change the job specific print option settings using Command WorkStation overrides.
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Scenario 2: Check the calibration status
Use the following procedure to check the calibration status prior to printing a job.
TO CHECK THE CALIBRATION STATUS AND PRINT WITH THE OPTIMUM CALIBRATION CONDITION
1 Click the Reporting print option bar.

2 If you have not printed the Detailed Report, select Detailed Report Only from the Postflight
menu.
If you have printed the Detailed Report and are familiar with the content, select Concise
Report Only.

For information about Postflight reports, see page 100.
3 Click OK.
4 Click Print.

The Detailed Report or Concise Report page is printed.
5 Review the information in the ColorWise global settings page.
6 Perform calibration, if needed.

If service has been performed on the print device since the last calibration, or calibration has
not been performed, perform calibration using the Calibration Set specified in the Postflight
report.
For more information about Calibration Set, see Color Printing.
7 Select Off from the Postflight list.
8 Click OK.
9 Click Print.
10 The job is printed to the newly calibrated Fiery EXP50.
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Scenario 3: Check the quality of the output profile
Use the following procedure to check the quality of the output profile of the print device.
TO CHECK THE QUALITY OF OUTPUT PROFILE AND PRINT WITH THE OPTIMUM OUTPUT PROFILE
1 Click the Reporting print option bar.

2 Select Test Page Only from the Postflight list.

For information about the Postflight Test Page, see page 99.
3 Click OK.
4 Click Print.

Postflight Test Page is printed to the Fiery EXP50.
5 Review the quality of the color on the Postflight Test Page.

N OTE : Make sure this page was printed with the same media and print option settings as

the job.
6 Review the instructions on the Postflight Test Page.
7 Edit the color of the output profile, or create a profile, if needed.

It may be necessary to customize the output profile or create one to get optimal results on the
media the job is using.
8 Select Off from the Postflight list.
9 Click OK.
10 Click Print.

The job is printed to the Fiery EXP50 with the edited or newly created output profile.
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Scenario 4: Diagnose a color problem of a specific object
Use the following procedure to diagnose a color problem.
TO DIAGNOSE A COLOR PROBLEM OF A SPECIFIC OBJECT AND PRINT WITH THE EDITED COLOR SETTINGS
1 Click the Reporting print option bar.

2 Select Color-Coded Page Only from the Postflight list.

For information about Postflight color-coded pages, see page 99.
3 Click OK.
4 Click Print.

Postflight color-coded pages are printed to the Fiery EXP50.
N OTE : Alternatively, you can send the Postflight color-coded pages to the Hold queue of the

Fiery EXP50 and preview them using ImageViewer. To preview the pages using ImageViewer,
make sure that your monitor is set up according to the manufacturer’s recommendations and
that the correct monitor profile is specified for your monitor. For information about monitor
profiles, see page 16.
5 Review the Postflight color-coded pages.
6 Make changes to the color settings, if needed.

For information about the ColorWise print options for various color spaces, see Color
Printing.
N OTE : Use the Color-Coded Pages Only setting to send a job to another print device that has

a specific color-space requirement. For example, a document targeted to a CMYK-only press
must have only Cyan-colored objects.
7 Select Off from the Postflight list.
8 Click OK.
9 Click Print.

The job is printed to the Fiery EXP50 with the edited color settings.
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MULTIPLE PLATE SEPARATIONS
The Multiple Plate Separations feature allows you to combine the multiple pre-separated
color plates of a PostScript job into a composite color print. It supports: Cyan, Magenta,
Yellow, Black, and one or more spot colors.
The results of combining the multiple plates are predictable and accurate, regardless of the
original application used. This feature also fully supports DCS 2.0 file formats when included
in a PostScript print job from a page layout application.

Multiple plate separations workflow
Use the following procedure to print a composite color print from the printer driver.
N OTE : The procedures for printing a composite color print from a Windows and a Mac OS

computer are similar.
TO PRINT A COMPOSITE COLOR PRINT
1 Open a color-separated document in a supported application.
2 Choose Print.
3 Select Fiery EXP50 as your printer and click Properties.

The Properties dialog box appears with the Fiery Printing tab selected.
4 Click the ColorWise print option bar.

5 Select Combine Separations.
6 Click Print.

A composite color print is printed to the Fiery EXP50.
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Combine Separations print option
Access the Multiple Plates Separations feature through the Combine Separations print option
from the printer driver.
The following values are available for the Combine Separations print option:
• Off (Default)
• On

Supported applications
The following applications have been tested with Mac OS and Windows for compatibility
with the Multiple Plates Separations feature:
• Adobe Acrobat 6
• Adobe Illustrator 8, 9, 10, and CS
• Adobe InDesign 1.5, 2, and CS
• Adobe PageMaker 6.5 and 7
• Macromedia FreeHand 9, 10, and MX
• QuarkXPress 4.1, 5, and 6
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AUTO TRAPPING
With trapping, some objects are printed slightly larger or smaller than you have specified in an
application, in order to prevent white edges around the objects. These white edges or “gaps”
can be can be the result of mis-registration, ink or toner, or stiff media.
Certain fixed values are used for the fixed Auto Trapping feature, and those values are
automatically applied to correct the “gaps” in a document when this feature is enabled.
N OTE : The “configurable” Auto Trapping feature is also offered in Graphic Arts Package,

Premium Edition. For more information about configurable Auto Trapping, see page 62.

Fixed Auto Trapping workflow
Use the following procedure to print a job with the fixed Auto Trapping feature On.
N OTE : The procedures for setting the Auto Trapping print option from a Windows and a

Mac OS computer are similar.
TO PRINT WITH THE FIXED AUTO TRAPPING FEATURE ON
1 Choose Print from an application.
2 Select Fiery EXP50 as your printer and click Properties.

The Properties dialog box appears, with the Fiery Printing tab selected.
3 Click the Image Quality print option bar.

4 Select Auto Trapping.
5 Click OK.
6 Click Print.

The job is printed with the fixed Auto Trapping feature.

AUTO TRAPPING

Auto Trapping print option
Specify whether to use the fixed Auto Trapping feature from the printer driver.
The following values are available for the Auto Trapping print option:
• Off
• On
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PAPER SIMULATION
The Paper Simulation feature gives you the benefit of the absolute colorimetric rendering that
renders the white point of the source color space as a visible color in the output profile color
space.

Paper Simulation workflow
Use the following procedure to print a job with the fixed Paper Simulation feature On.
N OTE : The procedures for setting the Paper Simulation print option from a Windows and a

Mac OS computer are similar.
TO PRINT WITH THE FIXED PAPER SIMULATION FEATURE ON
1 Choose Print from an application.
2 Select Fiery EXP50 as your printer and click Properties.

The Properties dialog box appears with the Fiery Printing tab selected.
3 Click the ColorWise print option bar and then click Expert Settings.

The Expert Color Settings dialog box appears.

4 Select the Paper Simulation print option and click OK.
5 Click Print.

The job is printed with the fixed Paper Simulation feature.
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Paper Simulation print option
Turn the Paper Simulation feature on or off through the print option from the printer driver.
• On: Performs Absolute Colorimetric rendering.
• Off (Default): Performs Relative Colorimetric rendering.
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